


Microsoft® Word 2010
Step by Step

Joyce Cox
Joan Lambert



PUBLISHED BY
Microsoft Press
A Division of Microsoft Corporation
One Microsoft Way
Redmond, Washington 98052-6399

Copyright © 2010 by Online Training Solutions, Inc.

All rights reserved. No part of the contents of this book may be reproduced or transmitted in any form or by any 
means without the written permission of the publisher.

Library of Congress Control Number: 2010928516

ISBN: 978-0-7356-2693-5

Printed and bound in the United States of America.

6 7 8 9 10 11 12 13 14  LSI  8 7 6 5 4 3

A CIP catalogue record for this book is available from the British Library.

Microsoft Press books are available through booksellers and distributors worldwide. For further infor mation about 
international editions, contact your local Microsoft Corporation office or contact Microsoft Press International 
directly at fax (425) 936-7329. Visit our Web site at www.microsoft.com/mspress. Send comments to mspinput@
microsoft.com.

Microsoft, Microsoft Press, Access, ActiveX, Excel, Internet Explorer, Outlook, PowerPoint, SharePoint, SkyDrive, 
SmartArt, SQL Server, Windows, Windows Live, and Windows Vista are either registered trademarks or trademarks 
of the Microsoft group of companies. Other product and company names mentioned herein may be the trademarks 
of their respective owners.

The example companies, organizations, products, domain names, e-mail addresses, logos, people, places, and 
events depicted herein are fictitious. No association with any real company, organization, product, domain name, 
e-mail address, logo, person, place, or event is intended or should be inferred.

This book expresses the author’s views and opinions. The information contained in this book is provided without 
any express, statutory, or implied warranties. Neither the authors, Microsoft Corporation, nor its resellers, or 
distributors will be held liable for any damages caused or alleged to be caused either directly or indirectly by 
this book.

Acquisitions Editor: Juliana Aldous
Developmental Editor: Devon Musgrave
Project Editor: Joel Panchot
Editorial Production: Online Training Solutions, Inc.
Cover: Girvin

Body Part No. X16-95387

[2013-04-05]



   iii

What do you think of this book? We want to hear from you! 
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources 
for you. To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey

Contents
Introducing Microsoft Word 2010. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix
Modifying the Display of the Ribbon . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xiii
Features and Conventions of This Book . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xix
Using the Practice Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxi
Your Companion eBook . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiv
Getting Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxv

Part 1  Basic Word Documents
 1 Explore Word 2010 3

Working in the User Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Creating, Entering Text in, and Saving Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

Document Compatibility with Earlier Versions of Word . . . . . . . . . . . . . . . . . . . 22
Opening, Moving Around in, and Closing Documents . . . . . . . . . . . . . . . . . . . . . . . . . 23
Viewing Documents in Different Ways . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

 2 Edit and Proofread Text 39
Making Text Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .40

Sidebar: About the Clipboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Finding and Replacing Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Fine-Tuning Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Correcting Spelling and Grammatical Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Sidebar: Viewing Document Statistics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69
Inserting Saved Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Sidebar: Inserting One Document into Another. . . . . . . . . . . . . . . . . . . . . . . . . . 73
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73



iv  Contents

 3 Change the Look of Text 75
Quickly Formatting Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76
Changing a Document’s Theme . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
Manually Changing the Look of Characters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Sidebar: Character Formatting and Case Considerations . . . . . . . . . . . . . . . . . . 95
Manually Changing the Look of Paragraphs. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95

Sidebar: Finding and Replacing Formatting . . . . . . . . . . . . . . . . . . . . . . . . . . . .106
Creating and Modifying Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .106

Sidebar: Formatting Text as You Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .112
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .113

 4 Organize Information in Columns and Tables 115
Presenting Information in Columns . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116
Creating Tabbed Lists . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .123
Presenting Information in Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .125

Sidebar: Performing Calculations in Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . .134
Sidebar: Other Layout Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .135

Formatting Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .136
Sidebar: Quick Tables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .140

Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 141

 5 Add Simple Graphic Elements 143
Inserting and Modifying Pictures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .144

Sidebar: About Clip Art. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .150
Changing a Document’s Background. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .152
Inserting Building Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159

Sidebar: Drawing Text Boxes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
Adding WordArt Text . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173

Sidebar: Formatting the First Letter of a Paragraph . . . . . . . . . . . . . . . . . . . . . 178
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179

 6 Preview, Print, and Distribute Documents 181
Previewing and Adjusting Page Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .182
Controlling What Appears on Each Page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .188
Printing Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .193
Preparing Documents for Electronic Distribution . . . . . . . . . . . . . . . . . . . . . . . . . . . .195
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .200



 Contents  v

Part 2  Document Enhancements
 7 Insert and Modify Diagrams 203

Creating Diagrams. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .203
Modifying Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 210
Creating Picture Diagrams . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .221

 8 Insert and Modify Charts 223
Inserting Charts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .223
Modifying Charts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .230
Using Existing Data in Charts. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .237
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 241

 9 Use Other Visual Elements 243
Adding Watermarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 243
Inserting Symbols and Equations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247

Sidebar: Setting Math AutoCorrect Options . . . . . . . . . . . . . . . . . . . . . . . . . . . .254
Drawing and Modifying Shapes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 255
Inserting Screen Clippings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .263
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .265

 10 Organize and Arrange Content 267
Reorganizing Document Outlines. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .268
Arranging Objects on the Page. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .273
Using Tables to Control Page Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .282
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .285

 11 Create Documents for Use Outside of Word 287
Saving Files in Different Formats . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .288

Sidebar: Viewing the .docx Format. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .288
Creating and Modifying Web Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .293
Creating and Publishing Blog Posts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .299

Sidebar: Setting Up a Blog Account . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .300
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .306



vi  Contents

Part 3  Additional Techniques
 12 Explore More Text Techniques 309

Adding Hyperlinks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 310
Inserting Fields. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 316
Adding Bookmarks and Cross-References . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .322
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .327

 13 Use Reference Tools for Longer Documents 329
Sidebar: Adding Footnotes and Endnotes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .330

Creating and Modifying Tables of Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 332
Sidebar: Tables of Figures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .338
Sidebar: Tables of Authorities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .339

Creating and Modifying Indexes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .340
Adding Sources and Compiling Bibliographies . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .347
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .353

 14 Work with Mail Merge 355
Understanding Mail Merge . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .356
Preparing Data Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .356

Sidebar: Using an Outlook Contacts List as a Data Source. . . . . . . . . . . . . . . .363
Preparing Main Documents. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .363
Merging Main Documents and Data Sources. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .367

Sidebar: Printing Envelopes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370
Sending Personalized E-Mail Messages  
to Multiple Recipients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 370
Creating and Printing Labels . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 374
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .377



 Contents  vii

What do you think of this book? We want to hear from you! 
Microsoft is interested in hearing your feedback so we can continually improve our books and learning resources 
for you. To participate in a brief online survey, please visit: 

microsoft.com/learning/booksurvey

 15 Collaborate on Documents 379
Coauthoring Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .380
Sending Documents Directly from Word . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .381

Sidebar: Adding Digital Signatures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .384
Adding and Reviewing Comments . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .385
Tracking and Managing Document Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .388
Comparing and Merging Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .393
Password-Protecting Documents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .396

Sidebar: Restricting Who Can Do What to Documents. . . . . . . . . . . . . . . . . . .400
Controlling Changes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .400
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .403

 16 Work in Word More Efficiently 405
Working with Styles and Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .406

Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .406
Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .409
Switching to a Different Template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .420

Changing Default Program Options. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .422
Sidebar: Using Add-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .430

Customizing the Ribbon. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431
Customizing the Quick Access Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 437
Key Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .440

Glossary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 441

Keyboard Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 449

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 471

About the Authors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 495





   ix

Introducing Microsoft Word 2010
Microsoft Word 2010 is a sophisticated word processing program that helps you quickly 
and efficiently author and format all the business and personal documents you are ever 
likely to need. You can use Word to:

● Create professional-looking documents that incorporate impressive graphics such 
as charts and diagrams.

● Give documents a consistent look by applying styles and themes that control the 
font, size, color, and effects of text and the page background.

● Store and reuse ready-made content and formatted elements such as cover 
pages and sidebars.

● Create personalized e-mail messages and mailings to multiple recipients without 
repetitive typing.

● Make information in long documents accessible by compiling tables of contents, 
indexes, and bibliographies.

● Safeguard your documents by controlling who can make changes and the types 
of changes that may be made, as well as by removing personal and confidential 
information.

Word 2010 builds on previous versions to provide powerful tools for all your word 
processing needs. This introduction provides an overview of new features that we  
explore throughout the book.

New Features
If you’re upgrading to Word 2010 from a previous version, you’re probably most  
interested in the differences between the old and new versions and how they will  
affect you, as well as how to find out about them in the quickest possible way. The  
following sections list new features you will want to be aware of, depending on  
the version of Word you are upgrading from.
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If You Are Upgrading from Word 2007
If you have been using Word 2007, you might be wondering how Microsoft could have 
improved on what seemed like a pretty comprehensive set of features and tools. The list 
of new features includes the following:

● The Backstage view Finally, all the tools you need to work with your files, as 
opposed to their content, really are accessible from one location. You display 
the Backstage view by clicking the File tab, which replaces the Microsoft Office 
Button at the left end of the ribbon.

● Customizable ribbon The logical next step in the evolution of the command 
center introduced with Word 2007: Create your own tabs and groups to suit the 
way you work.

● Navigation task pane The replacement for the Document Map not only provides 
a means of navigating to any heading but also to any page or to any search term 
you enter.

● Unsaved file recovery How many times have you responded No without thinking 
to the "save changes" message when closing files, only to find that you have discarded 
work you wanted to keep? Word now preserves your unsaved files for a period of 
time, allowing you to recover them if you need them.

● Paste preview No more trial and error when moving items to new locations. Preview 
what an item will look like in each of the available formats, and then pick the one 
you want.

● Coauthoring A team of authors can now work simultaneously on a document 
stored on a Microsoft SharePoint 2010 server or in Windows Live SkyDrive.

● Language support These days, more business is conducted internationally across 
language lines than ever before. Not only can you easily tailor the language of your 
working environment, but you can also use new translation tools to collaborate 
with team members in other countries.

● Graphics editing Found the perfect picture, but its colors or style aren't quite 
right for your document? Now after inserting a picture, you can edit it in new 
ways. In addition to changing color, brightness, and contrast, you can remove  
the background and, most exciting of all, apply artistic effects that make it appear 
like a watercolor, pencil drawing, or pastel sketch.
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● Text effects WordArt has had a makeover. Not only can WordArt be used to create 
distinctive headlines but its effects can be used on any text.

● Screenshots You no longer need to go outside of Word when you want to 
insert a screenshot into a document. This capability is now built into Word.

● Improved SmartArt Graphics tool A whole new category has been added to 
SmartArt so that you can include pictures as well as text in your diagrams.

If You Are Upgrading from Word 2003
In addition to the features listed in the previous section, if you’re upgrading from Word 
2003, you’ll want to take note of the new features that were introduced in Word 2007. 
The 2007 upgrade provided a more efficient working environment and included a long 
list of new and improved features, including the following:

● The Microsoft Office Fluent Ribbon No more hunting through menus, submenus, 
and dialog boxes. This new interface organizes all the commands most people use 
in a new way, making them quickly accessible from tabs at the top of the program 
window.

● Live Preview See the effect of a formatting option before you apply it.

● Building blocks Think AutoText on steroids! Predefined building blocks include 
sets of matching cover pages, quote boxes, sidebars, and headers and footers.

● Style sets and document themes Quickly change the look of a document by 
applying a different style set or theme, previewing its effect before making a 
selection.

● SmartArt Graphics tool Use this awesome new diagramming tool to create sophis-
ticated diagrams with three-dimensional shapes, transparency, drop shadows, and 
other effects.

● Improved charting Enter data in a linked Microsoft Excel worksheet and watch as 
your data is instantly plotted in the chart type of your choosing.

● Document cleanup Have Word check for and remove comments, hidden text, and 
personal information stored as properties before you declare a document final.

● New file format The new Microsoft Office Open XML Formats reduce file size and 
help avoid loss of data.
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Let’s Get Started!
We’ve been working with Word since its debut, and each version has offered something 
that made daily document creation a little easier. Microsoft Word 2010 is no exception, 
and we look forward to showing you around.
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Modifying the Display of the Ribbon
The goal of the Microsoft Office working environment is to make working with Office docu- 
ments, including Microsoft Word documents, Excel workbooks, PowerPoint presentations, 
Outlook e-mail messages, and Access database tables, as intuitive as possible. You work 
with an Office document and its contents by giving commands to the program in which 
the document is open. All Office 2010 programs organize commands on a horizontal bar 
called the ribbon, which appears across the top of each program window whether or not 
there is an active document.

Ribbon tabs Ribbon groups

A typical program window ribbon.

Commands are organized on task-specific tabs of the ribbon, and in feature-specific 
groups on each tab. Commands generally take the form of buttons and lists. Some  
appear in galleries. Some groups have related dialog boxes or task panes that contain 
additional commands. 

Throughout this book, we discuss the commands and ribbon elements associated with 
the program feature being discussed. In this topic, we discuss the general appearance 
of the ribbon, things that affect its appearance, and ways of locating commands that 
aren’t visible on compact views of the ribbon.

See Also  For detailed information about the ribbon in Microsoft Word, see “Working in the 
User Interface” in Chapter 1, “Explore Word 2010.”

Tip Some older commands no longer appear on the ribbon, but are still available in the 
program. You can make these commands available by adding them to the Quick Access 
Toolbar. For more information, see “Customizing the Quick Access Toolbar” in Chapter 16, 
“Work in Word More Efficiently.”
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Dynamic Ribbon Elements
The ribbon is dynamic, meaning that the appearance of commands on the ribbon 
changes as the width of the ribbon changes. A command might be displayed on the 
ribbon in the form of a large button, a small button, a small labeled button, or a list 
entry. As the width of the ribbon decreases, the size, shape, and presence of buttons 
on the ribbon adapt to the available space.

For example, when sufficient horizontal space is available, the buttons on the Review 
tab of the Word program window are spread out and you’re able to see more of the 
commands available in each group.

Drop-down list
Small labeled button

Large button

The Review tab of the Word program window at 1024 pixels wide.

If you decrease the width of the ribbon, small button labels disappear and entire groups 
of buttons hide under one button that represents the group. Click the group button to 
display a list of the commands available in that group.

Group button Small unlabeled buttons

The Review tab of the Word program window at 675 pixels wide.

When the window becomes too narrow to display all the groups, a scroll arrow appears 
at its right end. Click the scroll arrow to display hidden groups.
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Scroll arrow

The Review tab of the Word program window at 340 pixels wide.

Changing the Width of the Ribbon
The width of the ribbon is dependent on the horizontal space available to it, which 
depends on these three factors:

● The width of the program window Maximizing the program window provides 
the most space for ribbon elements. You can resize the program window by 
clicking the button in its upper-right corner or by dragging the border of a 
non-maximized window.

Tip On a computer running Windows 7, you can maximize the program window by 
dragging its title bar to the top of the screen.

● Your screen resolution Screen resolution is the size of your screen display expressed 
as pixels wide × pixels high. The greater the screen resolution, the greater the amount 
of information that will fit on one screen. Your screen resolution options are depen-
dent on your monitor. At the time of writing, possible screen resolutions range from 
800 × 600 to 2048 × 1152. In the case of the ribbon, the greater the number of pixels 
wide (the first number), the greater the number of buttons that can be shown on the 
ribbon, and the larger those buttons can be.

On a computer running Windows 7, you can change your screen resolution from 
the Screen Resolution window of Control Panel. 
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You set the resolution by dragging the pointer on the slider.

● The density of your screen display You might not be aware that you can change the 
magnification of everything that appears on your screen by changing the screen mag-
nification setting in Windows. Setting your screen magnification to 125% makes text 
and user interface elements larger on screen. This increases the legibility of informa-
tion, but means that less fits onto each screen.

On a computer running Windows 7, you can change the screen magnification from 
the Display window of Control Panel.
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You can choose one of the standard display magnification options, or create another by 
setting a custom text size.

The screen magnification is directly related to the density of the text elements on 
screen, which is expressed in dots per inch (dpi) or points per inch (ppi). (The terms 
are interchangeable, and in fact are both used in the Windows dialog box in which 
you change the setting.) The greater the dpi, the larger the text and user interface 
elements appear on screen. By default, Windows displays text and screen elements 
at 96 dpi. Choosing the Medium - 125% display setting changes the dpi of text 
and screen elements to 120 dpi. You can choose a custom setting of up to 500% 
magnification, or 480 dpi, in the Custom DPI Setting dialog box.

You can choose a magnification of up to 200% from the lists, or choose  
a greater magnification by dragging across the ruler from left to right.
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See Also  For more information about display settings, refer to Windows 7 Step by Step 
(Microsoft Press, 2009), Windows Vista Step by Step (Microsoft Press, 2006), or Windows XP 
Step by Step (Microsoft Press, 2002) by Joan Lambert Preppernau and Joyce Cox.

Adapting Exercise Steps
The screen images shown in the exercises in this book were captured at a screen resolu-
tion of 1024 × 768, at 100% magnification, and the default text size (96 dpi). If any of 
your settings are different, the ribbon on your screen might not look the same as the one 
shown in the book. For example, you might see more or fewer buttons in each of the 
groups, the buttons you see might be represented by larger or smaller icons than those 
shown, or the group might be represented by a button that you click to display the 
group’s commands.

When we instruct you to give a command from the ribbon in an exercise, we do it in this 
format:

● On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list, we give the instruction in this format:

● On the Page Layout tab, in the Page Setup group, click the Breaks button and 
then, in the list, click Page.

The first time we instruct you to click a specific button in each exercise, we display an 
image of the button in the page margin to the left of the exercise step.

If differences between your display settings and ours cause a button on your screen to 
look different from the one shown in the book, you can easily adapt the steps to locate 
the command. First, click the specified tab. Then locate the specified group. If a group 
has been collapsed into a group list or group button, click the list or button to display 
the group’s commands. Finally, look for a button that features the same icon in a larger 
or smaller size than that shown in the book. If necessary, point to buttons in the group 
to display their names in ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while you 
read and work through the exercises in the book.
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Features and Conventions  
of This Book

This book has been designed to lead you step by step through all the tasks you’re 
most likely to want to perform in Microsoft Word 2010. If you start at the beginning 
and work your way through all the exercises, you will gain enough proficiency to be 
able to create and work with all the common types of Word documents. However, 
each topic is self contained. If you have worked with a previous version of Word, or if 
you completed all the exercises and later need help remembering how to perform a 
procedure, the following features of this book will help you locate specific information:

● Detailed table of contents Search the listing of the topics and sidebars within 
each chapter.

● Chapter thumb tabs Easily locate the beginning of the chapter you want.

● Topic-specific running heads Within a chapter, quickly locate the topic you 
want by looking at the running heads at the top of odd-numbered pages.

● Glossary Look up the meaning of a word or the definition of a concept.

● Keyboard Shortcuts If you prefer to work from the keyboard rather than with a 
mouse, find all the shortcuts in one place.

● Detailed index Look up specific tasks and features in the index, which has been 
carefully crafted with the reader in mind.

You can save time when reading this book by understanding how the Step by Step series 
shows exercise instructions, keys to press, buttons to click, and other information. These 
conventions are listed in the table on the next page.
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Convention Meaning
SET UP This paragraph preceding a step-by-step exercise indicates the 

practice files that you will use when working through the exercise. It 
also indicates any requirements you should attend to or actions you 
should take before beginning the exercise.

CLEAN UP This paragraph following a step-by-step exercise provides instructions 
for saving and closing open files or programs before moving on to 
another topic. It also suggests ways to reverse any changes you made 
to your computer while working through the exercise.

1
2

Blue numbered steps guide you through hands-on exercises in each 
topic.

1

2

Black numbered steps guide you through procedures in sidebars and 
expository text.

See Also This paragraph directs you to more information about a topic in this 
book or elsewhere.

Troubleshooting This paragraph alerts you to a common problem and provides 
guidance for fixing it.

Tip This paragraph provides a helpful hint or shortcut that makes working 
through a task easier.

Important This paragraph points out information that you need to know to 
complete a procedure.

Keyboard Shortcut This paragraph provides information about an available keyboard 
shortcut for the preceding task.

Ctrl+B A plus sign (+) between two keys means that you must press those 
keys at the same time. For example, “Press Ctrl+B” means that you 
should hold down the Ctrl key while you press the B key.
Pictures of buttons appear in the margin the first time the button is 
used in a chapter.

Black bold In exercises that begin with SET UP information, the names of program 
elements, such as buttons, commands, windows, and dialog boxes, 
as well as files, folders, or text that you interact with in the steps, are 
shown in black, bold type.

Blue bold In exercises that begin with SET UP information, text that you should 
type is shown in blue bold type.
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Using the Practice Files
Before you can complete the exercises in this book, you need to copy the book’s 
practice files to your computer. These practice files, and other information, can be 
downloaded from the book’s support page, located at:

http://go.microsoft.com/fwlink/?Linkid=192147

Display the support page in your Web browser and follow the instructions for downloading 
the files.

Important The Microsoft Word 2010 program is not available from this Web site. You should 
purchase and install that program before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 1:  
Explore Word 2010

Prices_start.docx
Procedures_start.docx
Rules_start.docx

Chapter 2:  
Edit and Proofread

Bamboo_start.docx
Brochure_start.docx
Letter_start.docx
Orientation_start.docx
RulesRegulations_start.docx

Chapter 3:  
Change the Look of Text

AgendaA_start.docx
AgendaB_start.docx
Information_start.docx
OrientationDraft_start.docx
RulesDraft_start.docx

Chapter 4:  
Organize Information in Columns and Tables

ConsultationA_start.docx
ConsultationB_start.docx
RepairCosts_start.docx
RoomPlanner_start.docx

(continued)
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Chapter File
Chapter 5:  
Add Simple Graphic Elements

Announcement_start.docx
Authors_start.docx
Flyer_start.docx
Joan.jpg
Joyce.jpg
MarbleFloor.jpg
OTSI-Logo.png

Chapter 6:  
Preview, Print, and Distribute Documents

InfoSheetA_start.docx
InfoSheetB_start.docx
InfosheetC_start.docx
OfficeInfo_start.docx

Chapter 7:  
Insert and Modify Diagrams

Garden.jpg
Park.jpg
Pond.jpg
ServiceA_start.docx
ServiceB_start.docx
Woods.jpg

Chapter 8:  
Insert and Modify Charts

CottageA_start.docx
CottageB_start.docx
CottageC_start.docx
Temperature.xlsx

Chapter 9:  
Use Other Visual Elements

AgendaDraft_start.docx
AuthorsDraft_start.docx
OTSI-Logo.jpg
Welcome_start.docx

Chapter 10:  
Organize and Arrange Content

BambooInfo_start.docx
DeliveryTruckPurchase.docx
Loan.xlsx
LoanComparisons_start.docx
OfficeProcedures_start.docx



 Using the Practice Files  xxiii

Chapter File
Chapter 11:  
Create Documents for Use Outside of Word

BlogPost.docx
ParkingRules_start.docx
RoomPlannerWeb_start.docx

Chapter 12:  
Explore More Text Techniques

Conductors.docx
ProceduresFields_start.docx
RulesBookmarks_start.docx
VisitorGuide_start.docx

Chapter 13:  
Use Reference Tools for Longer Documents

AllAboutBamboo_start.docx
BambooBibliography_start.docx
ProceduresContents_start.docx
RulesIndex_start.docx

Chapter 14:  
Work with Mail Merge

AnniversaryLetter_start.docx
CustomerList_start.xlsx
ThankYouEmail_start.docx

Chapter 15:  
Collaborate on Documents

CompetitiveAnalysisA_start.docx
CompetitiveAnalysisB_start.docx
InfoSheetReviewA_start.docx
InfoSheetReviewB_start.docx
InfoSheetReviewC_start.docx
LoansProtected_start.docx
ProceduresRestricted_start.docx
ServiceCP_start.docx
ServiceSH_start.docx
ServiceTA_start.docx

Chapter 16:  
Work in Word More Efficiently

AgendaSH_start.docx
AuthorsTemplate_start.docx
ProceduresEdited_start.docx



Your Companion eBook 
The eBook edition of this book allows you to: 

● Search the full text 

● Print 

● Copy and paste 

To download your eBook, please see the instruction page at the back of this book.
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Getting Help
Every effort has been made to ensure the accuracy of this book. If you do run into 
problems, please contact the sources listed in the following sections.

Getting Help with This Book
If your question or issue concerns the content of this book or its practice files, please 
first consult the book’s errata page, which can be accessed at:

http://go.microsoft.com/fwlink/?Linkid=192147

This page provides information about known errors and corrections to the book. If 
you do not find your answer on the errata page, send your question or comment to 
Microsoft Press Technical Support at:

mspinput@microsoft.com

Getting Help with Word 2010
If your question is about Microsoft Word 2010, and not about the content of this book, 
your first recourse is the Word Help system. This system is a combination of tools and 
files stored on your computer when you installed Word and, if your computer is con-
nected to the Internet, information available from Office.com. You can find general or 
specific Help information in the following ways:

● To find out about an item on the screen, you can display a ScreenTip. For example, to 
display a ScreenTip for a button, point to the button without clicking it. The ScreenTip 
gives the button’s name, the associated keyboard shortcut if there is one, and unless 
you specify otherwise, a description of what the button does when you click it.

● In the Word program window, you can click the Microsoft Word Help button (a 
question mark in a blue circle) at the right end of the ribbon to display the Word 
Help window. 

● After opening a dialog box, you can click the Help button (also a question mark) 
at the right end of the dialog box title bar to display the Word Help window. 
Sometimes, topics related to the functions of that dialog box are already identified 
in the window.
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To practice getting help, you can work through the following exercise.

SET UP You don’t need any practice files to complete this exercise. Start Word, and 
then follow the steps.

 1. At the right end of the ribbon, click the Microsoft Word Help button.

The Word Help window opens.

You can maximize the window or adjust its size by dragging the handle in the lower-right 
corner. You can change the size of the font by clicking the Change Font Size button on the 
toolbar.

If you are connected to the Internet, clicking any of the buttons below the 
Microsoft Office banner (Products, Support, Images, and Templates) takes  
you to a corresponding page of the Office Web site.

 2. Below the bulleted list under Browse Word 2010 support, click see all.

The window changes to display a list of help topics.

 3. In the list of topics, click Activating Word.
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Word Help displays a list of topics related to activating Microsoft Office programs. 
You can click any topic to display the corresponding information.

 4. On the toolbar, click the Show Table of Contents button.

The window expands to accommodate two panes. The Table Of Contents pane 
appears on the left. Like the table of contents in a book, it is organized in sections.  
If you’re connected to the Internet, Word displays sections, topics, and training 
available from the Office Online Web site as well as those stored on your computer.

Clicking any section (represented by a book icon) displays that section’s topics (represented by 
help icons).

 5. In the Table of Contents pane, click a few sections and topics. Then click the Back 
and Forward buttons to move among the topics you have already viewed.

 6. At the right end of the Table of Contents title bar, click the Close button.

 7. At the top of the Word Help window, click the Type words to search for box, 
type saving, and then press the Enter key.

The Word Help window displays topics related to the word you typed.
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Next and Back buttons appear to make it easier to search for the topic you want.

 8. In the results list, click the Recover earlier versions of a file in Office 2010 topic.

The selected topic appears in the Word Help window.

 9. Below the title at the top of the topic, click Show All.

Word displays any hidden auxiliary information available in the topic and changes 
the Show All button to Hide All. You can jump to related information by clicking 
hyperlinks identified by blue text.

Tip You can click the Print button on the toolbar to print a topic. Only the displayed 
information is printed.

CLEAN UP Click the Close button at the right end of the Word Help window.
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More Information
If your question is about Microsoft Word 2010 or another Microsoft software product and 
you cannot find the answer in the product’s Help system, please search the appropriate 
product solution center or the Microsoft Knowledge Base at:

support.microsoft.com

In the United States, Microsoft software product support issues not covered by the 
Microsoft Knowledge Base are addressed by Microsoft Product Support Services. 
Location-specific software support options are available from:

support.microsoft.com/gp/selfoverview/
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 4 Organize 
  Information in  
  Columns and Tables
In this chapter, you will learn how to
✔ Present information in columns.
✔ Create tabbed lists.
✔ Present information in tables.
✔ Format tables.

Information in documents is most commonly presented as paragraphs of text. To make 
a text-heavy document more legible, you can flow the text in two or more columns, or 
you can display information in a table. For example, flowing text in multiple columns is 
a common practice in newsletters, flyers, and brochures; and presenting information in 
tables is common in reports.

When you need to present data in a document, using a table is often more efficient than 
describing the data in a paragraph, particularly when the data consists of numeric values. 
Tables make the data easier to read and understand. A small amount of data can be dis-
played in simple columns separated by tabs, which creates a tabbed list. A larger amount 
of data, or more complex data, is better presented in a table, which is a structure of rows 
and columns, frequently with row and column headings.

In this chapter, you’ll first create and modify columns of text. Then you’ll create a simple 
tabbed list. Finally, you’ll create tables from scratch and from existing text, and format 
a table in various ways.

Practice Files Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter04 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.
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Presenting Information in Columns
By default, Microsoft Word 2010 displays text in one column that spans the width of the 
page between the left and right margins. You can specify that text be displayed in two, 
three, or more columns to create layouts like those used in newspapers and magazines. 
When you format text to flow in columns, the text fills the first column on each page 
and then moves to the top of the next column. You can manually indicate where you 
want the text within each column to end.

The Columns gallery in the Page Setup group on the Page Layout tab displays several 
standard options for dividing text into columns. You can choose one, two, or three 
columns of equal width or two columns of unequal width. If the standard options 
don’t suit your needs, you can specify the number and width of columns. The number 
of columns is limited by the width and margins of the page, and each column must be 
at least a half inch wide.

The Columns gallery displays the predefined column options.

No matter how you set up the columns initially, you can change the layout or column 
widths at any time.

You can format an entire document or a section of a document in columns. When you 
select a section of text and format it as columns, Word inserts section breaks at the begin-
ning and end of the selected text to delineate the area in which the columnar formatting is 
applied. Within the columnar text, you can insert column breaks to specify where you want 
to end one column and start another. Section and column breaks are visible when you dis-
play formatting marks in the document.



Tip You can apply many types of formatting, including page orientation, to content within 
a specific section of a document without affecting the surrounding text. For information 
about sections, see “Controlling What Appears on Each Page” in Chapter 6, “Preview, Print, 
and Distribute Documents.”

See Also For information about formatting marks, see ”Viewing Documents in Different 
Ways” in Chapter 1, “Explore Word 2010.”

You can apply character and paragraph formatting to columnar text in the same way you 
would any text. Here are some formatting tips for columnar text:

● When presenting text in narrow columns, you can justify the paragraphs (align 
the text with the left and right edges) to achieve a neat and clean appearance. 
To justify the paragraphs, Word adjusts the spacing between words, essentially 
moving the empty space that would normally appear at the end of the line into 
the gaps between words.

● To more completely fill columns, you can have Word hyphenate the text to break 
words into syllables to fill up the gaps.

In this exercise, you’ll flow the text in one section of a document into three columns. 
You’ll justify the text in the columns, change the column spacing, and hyphenate the 
text. You’ll then break a column at a specific location instead of allowing the text to flow 
naturally from one column to the next.

SET UP You need the RoomPlanner_start document located in your Chapter04 practice 
file folder to complete this exercise. Open the RoomPlanner_start document, and save 
it as RoomPlanner. Then display formatting marks and the rulers, and follow the steps.

 1. Click at the beginning of the paragraph that begins Take a look (do not click in the 
selection area). Then scroll down until you can see the end of the document, hold 
down the Shift key, and click to the right of the paragraph mark after credit cards.

Word selects the text from the Take a look paragraph through the end of the last 
paragraph (but not the empty paragraph).

Tip If you want to format an entire document with the same number of columns, you 
can simply click anywhere in the document—you don’t have to select the text.

 2. On the Page Layout tab, in the Page Setup group, click the Columns button, and 
then in the Columns gallery, click Three.

Word inserts a section break above the selected text and flows the text within the 
section into three columns.
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 3. Press Ctrl+Home to move to the top of the document.

The section break is visible above the columns.

A continuous section break changes the formatting of the subsequent text but keeps it on the 
same page.

 4. On the Home tab, in the Editing group, click the Select button, and then click 
Select All.

Keyboard Shortcut Press Ctrl+A to select all the text in the document.

See Also To see a complete list of keyboard shortcuts, see “Keyboard Shortcuts” at the 
end of this book.

 5. In the Paragraph group, click the Justify button.

Keyboard Shortcut Press Ctrl+J to justify paragraphs.

The spacing between the words changes to align all the paragraphs in the document 
with both the left and right margins. Because you applied the formatting to the entire 
document, the title is no longer centered. However, it is often quicker to apply format-
ting globally and then deal with the exceptions.



 6. Press Ctrl+Home to move to the paragraph containing the document title. Then in 
the Paragraph group, click the Center button.

Keyboard Shortcut Press Ctrl+E to center text.

Word centers the document title between the left and right margins.

 7. Adjust the zoom percentage until you can see about two-thirds of the first page of 
the document.

See Also For information about adjusting the zoom percentage, see “Viewing 
Documents in Different Ways” in Chapter 1, “Explore Word 2010.”

 8. Click anywhere in the first column.

On the horizontal ruler, Word indicates the margins of the columns.

On the ruler, the indent markers show the indentation of the active column.

Tip If your rulers aren’t turned on, select the Ruler check box in the Show group of the 
View tab.
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 9. On the Page Layout tab, display the Columns gallery, and click More Columns.

The Columns dialog box opens. The spacing between columns is set by default to a 
half inch.

Because the Equal Column Width check box is selected, you can adjust the width  
and spacing of only the first column.

Tip To separate the columns with vertical lines, select the Line Between check box.

 10. In the Width and spacing area, in the Spacing box for column 1, type or 
select 0.2".

Word changes the measurement in the Spacing box for column 2, and widens all 
the columns in the Preview area to reflect the new setting.

 11. Click OK.

Word reflows the columns to fit their new margins.



Wider columns generally look neater on the page.

 12. Click at the beginning of the Take a look paragraph. Then in the Page Setup 
group, click the Hyphenation button, and click Automatic.

Word hyphenates the text of the document, which fills in some of the large gaps 
between words.

 13. Click anywhere in the NOTE paragraph in the third column.

 14. On the horizontal ruler, at the left end of the third column, drag the Hanging 
Indent marker 0.25 inch (two marks) to the right.

All the lines in the NOTE paragraph except the first are now indented, offsetting 
the note from the paragraphs above and below it.
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You can change the indentation of individual paragraphs within a column.

 15. Display the bottom of page 1. In the first column on page 1, click at the beginning 
of the Take your Room Planner home paragraph. Then in the Page Setup group, 
click the Breaks button, and click Column.

Word inserts a column break. The text that follows the column break moves to the 
top of the second column.

 16. At the bottom of the third column on page 1, click at the beginning of the If you’re 
not sure paragraph, and then on the Quick Access Toolbar, click the Repeat Insertion 
button to insert another column break.

Keyboard Shortcut Press Ctrl+Y to repeat the previous action.

Word inserts a column break. The text that follows the column break moves to the 
top of the first column on page 2.

CLEAN UP Return the Zoom Level setting to 100%, and then save and close the 
RoomPlanner document.
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If you have a relatively small amount of data to present, you might choose to display 
it in a tabbed list, which arranges text in simple columns separated by tabs. You can 
align the text within the columns by using left, right, centered, or decimal tab stops.

See Also For more information about setting tab stops, see “Manually Changing the Look of 
Paragraphs” in Chapter 3, “Change the Look of Text.”

When entering text in a tabbed list, inexperienced Word users have a tendency to 
press the Tab key multiple times to align the columns of the list with the default tab 
stops. If you do this, you have no control over the column widths. To be able to  
fine-tune the columns, you need to set custom tab stops rather than relying on the 
default ones. 

When setting up a tabbed list, you should press Tab only once between the items that 
you want to appear in separate columns. Next you apply any necessary formatting. And 
finally, you set the custom tab stops. Set left, right, centered, and decimal tabs to control 
the alignment of the column content, or set a bar tab to add a vertical line to visually 
separate list columns. By setting the tabs in order from left to right, you can check the 
alignment of the text within each column as you go.

In this exercise, you’ll first enter text separated by tabs and format the text. Then you’ll 
set custom tab stops to create a tabbed list.

SET UP You need the ConsultationA_start document located in your Chapter04 
practice file folder to complete this exercise. Open the ConsultationA_start 
document, and save it as ConsultationA. Then display formatting marks and the 
rulers, and follow the steps.

 1. Set the zoom percentage to a level that is comfortable for you, and then press 
Ctrl+End to move the cursor to the blank line at the end of the document.

 2. Type Location, press Tab, type Discount Applies, press Tab, type Hourly Rate, 
and then press Enter.
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 3. Add three more lines to the list by typing the following text, pressing the Tab and 
Enter keys where indicated.

In home Tab No Tab $50.00 Enter
Phone Tab Yes Tab $35.00 Enter
In store Tab Yes Tab $40.00 Enter

The tab characters push the items to the next default tab stop, but because some 
items are longer than others, they do not line up.

In a tabbed list, it’s important to press the Tab key only once between items.

 4. Select the first line of the tabbed list, and then on the Mini Toolbar that appears, 
click the Bold button.

Troubleshooting If the Mini Toolbar doesn’t appear, click the Bold button in the Font 
group on the Home tab.

Keyboard Shortcut Press Ctrl+B to apply bold.

 5. Select all four lines of the tabbed list, and then on the Mini Toolbar, click the 
Increase Indent button.

Tip It’s more efficient to make all character and paragraph formatting changes to the 
text before setting tab stops. Otherwise, you might have to adjust the tab stops after 
applying the formatting.

 6. With the tabbed list still selected, on the Page Layout tab, in the Paragraph 
group, under Spacing, change the After setting to 0 pt.

 7. Click the tab setting button at the junction of the horizontal and vertical rulers until 
the Center Tab button is active. (You will probably have to click only once.) Then 
click the 2.5 inch mark on the horizontal ruler.



On the ruler, Word sets a center-aligned tab stop that looks like the Center Tab icon. 
The items in the second column of the tabbed list center themselves at that position.

 8. Click the tab setting button once.

The Right Tab button is now active.

 9. With the Right Tab button active, click the horizontal ruler at the 4.5 inch mark.

On the ruler, Word sets a right-aligned tab stop that looks like the Right Tab icon. The 
items in the third column of the tabbed list right-align themselves at that position.

 10. On the Home tab, in the Paragraph group, click the Show/Hide ¶ button to hide 
the tabs, paragraph marks, and other formatting marks. Then click away from the 
tabbed list to see the results.

The tabbed list resembles a simple table.

You have created a simple table-like layout with just a few clicks.

CLEAN UP Save the ConsultationA document, and then close it.

Presenting Information in Tables
A table is a structure of vertical columns and horizontal rows. Each column and each row 
can be named with a heading, although some tables have only column headings or only 
row headings. At the junction of each column and row is a box called a cell in which data 
(text or numeric information) is stored.
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You can create empty or predefined tables in a Word document in the following ways:

● The Insert Table gallery, which is available from the Tables group on the Insert tab, 
displays a simple grid. 

You can create a simple table from the grid in the Insert Table gallery.

Clicking a cell in the grid inserts an empty table the width of the text column. The 
table has the number of rows and columns you indicated in the grid, with all the rows 
one line high and all the columns of an equal width.

● To insert a more customized empty table, you can click Insert Table on the menu at 
the bottom of the Insert Table gallery to open the Insert Table dialog box, in which 
you can specify the number of rows and columns and customize the column width.

You can create a custom-width table from the Insert Table dialog box.



● To insert a less clearly defined empty table, you can click Draw Table below the grid 
in the Insert Table gallery. This command displays a pencil with which you can draw 
cells directly in the Word document to create a table. The cells you draw connect by 
snapping to a grid, but you have some control over the size and spacing of the rows 
and columns.

You can draw a table directly on the page.

See Also For information about drawing tables, see “Using Tables to Control Page Layout” 
in Chapter 10, “Organize and Arrange Content.”

● In addition to empty tables, you can insert any of the available Quick Tables, 
which are predefined tables of formatted data that you can replace with your 
own information. Built-in Quick Tables include a variety of calendars, simple  
tables, tables with subheadings, and tabbed lists. You can also save your own 
custom tables to the Quick Tables gallery so that you can easily insert a frequently 
used table structure and data into any document.

The Quick Tables gallery includes a selection of predefined tables such as this one.
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A new table appears in the document as a set of cells, usually bordered by gridlines. (In 
some Quick Tables, the gridlines are turned off.) Each cell contains an end-of-cell marker, 
and each row ends with an end-of-row marker. (The end-of-cell markers and end-of-row 
markers are identical in appearance, and are visible only when you display formatting 
marks in the document.) When you point to a table, a move handle appears in its upper-
left corner and a size handle in its lower-right corner. When the cursor is in a table, two 
Table Tools contextual tabs—Design and Layout—appear on the ribbon.

Move handle End-of-cell marker
End-of-row marker
Size handle

A table has its own controls and its own contextual ribbon tabs.

Tip The move handle and size handle appear only in Print Layout view and Web Layout view.

After you create a table, you can enter data (such as text, numbers, or graphics) into the 
table cells and press the Tab key to move the cursor from cell to cell. Pressing Tab when the 
cursor is in the last cell of a row moves the cursor to the first cell of the next row. Pressing 
Tab when the cursor is in the last cell of the last row adds a new row to the table and moves 
the cursor to the first cell of that row.

Tip You can move and position the cursor by pressing the Tab key or the Arrow keys, or by 
clicking in a table cell.

If the data you want to present in a table already exists in the document, either as regular 
text or as a tabbed list, you can convert the text to a table by selecting it and then clicking 
Convert Text To Table in the Insert Table gallery. Conversely, you can convert an active table 
to regular text by clicking the Convert To Text button in the Data group on the Layout tab.

You can modify a table’s structure by changing the size of the table, changing the size of 
one or more columns or rows, or adding or removing rows, columns, or individual cells. 



Tip To change a table’s structure, you often need to select the entire table or a specific column 
or row. The simplest way to do this is to position the cursor in the table, column, or row, click the 
Select button in the Table group on the Layout tab, and then click the table element you want. 
Alternatively, you can point to the top edge of a column or left edge of a row and, when the 
pointer changes to an arrow, click to select the column or row.

The basic methods for manipulating a table or its contents are as follows:

● Insert a row or column Click anywhere in a row or column adjacent to where you 
want to make the insertion. Then on the Layout tab, in the Rows & Columns group, 
click the Insert Above, Insert Below, Insert Left, or Insert Right button.

The Rows & Columns group of the Layout tab.

Selecting more than one row or column before you click an Insert button inserts 
that number of rows or columns in the table.

Tip You can insert cells by clicking the Rows & Columns dialog box launcher and 
specifying in the Insert Cells dialog box how adjacent cells should be moved to 
accommodate the new cells.

● Delete a row or column Click anywhere in the row or column, and in the Rows & 
Columns group, click the Delete button. Then click Delete Cells, Delete Columns, 
Delete Rows, or Delete Table.

● Resize an entire table Drag the size handle.

● Resize a single column or row Without selecting the column, drag its right border 
to the left or right. Without selecting the row, drag its bottom border up or down. 
(If you select a column or row and then drag its border, only the selected column 
or row changes.)

● Move a table Point to the table, and then drag the move handle that appears in 
its upper-left corner to a new location. Or use the Cut and Paste commands in the 
Clipboard group on the Home tab to move the table.

● Merge cells Create cells that span multiple columns or rows by selecting the cells 
you want to merge and clicking the Merge Cells button in the Merge group on the 
Layout tab. For example, to center a title in the first row of a table, you can merge 
all the cells in the row to create one merged cell that spans the table’s width.
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● Split cells Divide one cell into multiple cells by clicking the Split Cells button in the 
Merge group on the Layout tab and then specifying the number of columns and 
rows you want.

● Sort information Click the Sort button in the Data group on the Layout tab to sort 
the rows in ascending or descending order by the data in any column. For example, 
in a table that has the column headings Name, Address, ZIP Code, and Phone 
Number, you can sort on any one of those columns to arrange the information in 
alphabetical or numerical order.

In this exercise, you’ll work with two tables. First you’ll create an empty table, enter and 
align text in the table cells, add rows to the table, and merge cells. Then you’ll create a 
second table by converting an existing tabbed list, change the width of a column, and 
change the width of the entire table.

SET UP You need the ConsultationB_start document located in your Chapter04 practice 
file folder to complete this exercise. Open the ConsultationB_start document, and save it 
as ConsultationB. Then display formatting marks and the rulers, and follow the steps.

 1. Click to the left of the second blank paragraph below Please complete this form.

 2. On the Insert tab, in the Tables group, click the Table button. Then in the Insert 
Table gallery, point to (don’t click) the cell that is five columns to the right and five 
rows down from the upper-left corner of the grid.

Word highlights the cells that will be in the table, indicates the table dimensions 
in the gallery header, and creates a temporary table in the document.

You can preview the table with the number of columns and rows you have specified.



 3. Click the cell.

Word creates a blank table consisting of five columns and five rows. The cursor is 
located in the first cell. Because the table is active, Word displays the Design and 
Layout contextual tabs.

 4. In the selection area to the left of the table, point to the first row of the table, and 
then click once to select it.

 5. On the Layout contextual tab, in the Merge group, click the Merge Cells button.

Word combines the five cells in the first row into one cell.

 6. With the merged cell selected, in the Alignment group, click the Align Center button.

The end-of-cell marker moves to the exact center of the merged cell to indicate 
that anything you type there will be centered both horizontally and vertically.

 7. Type Consultation Estimate.

The table now has content that looks like a table title.

Merged cells are often used for table titles and column headings.

 8. Click the first cell in the second row, type Type, and then press Tab.

 9. Type Location, Consultant, Hourly Rate, and Total, pressing Tab after each entry.

Pressing Tab after the Total heading moves the cursor to the first cell of the third 
row. The table now has a row of column headings.

 10. Select the column heading row, and then on the Mini Toolbar, click the Bold button.

 11. In the third row, type Window treatments, In home, Andy Ruth, $50.00, and 
$50.00, pressing Tab after each entry.

You have entered a complete row of data.

 12. Select the last two rows, and then on the Layout tab, in the Rows & Columns 
group, click the Insert Below button.

Word adds two new rows and selects them.

 13. In the last row, click the first cell, hold down the Shift key, and then press the Right 
Arrow key four times to select the first four cells in the row.
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 14. In the Merge group, click the Merge Cells button.

Word combines the selected cells into one cell.

 15. In the Alignment group, click the Align Center Right button.

 16. Type Subtotal, and then press Tab twice.

Word adds a new row with the same structure to the bottom of the table.

When you add a new row, it has the same format as the one it is based on.

 17. Type Add trip fee, press Tab twice to add a new row, and then type Total.

Now you’ll create a different table by converting existing text.

 18. Scroll down to the bottom of the document, and select the rows of the tabbed list 
beginning with Distance and ending with $20.00.

 19. On the Insert tab, in the Tables group, click the Table button, and then click 
Convert Text to Table.

The Convert Text To Table dialog box opens.

You can separate text into columns based on the symbol you specify.



 20. Verify that the Number of columns box displays 2, and then click OK.

The selected text appears in a table with two columns and six rows.

 21. Click anywhere in the table to release the selection, and then point to the right 
border of the table. When the pointer changes to two opposing arrows, double-
click the border.

Word adjusts the width of the right column to accommodate its longest cell 
entry.

Tip You can also adjust the column width by changing the Table Column Width setting 
in the Cell Size group on the Layout tab.

 22. Point to the In-Home Trip Charge table.

Word displays the move handle in the upper-left corner and the size handle in 
the lower-right corner.

 23. Drag the size handle to the right, releasing the mouse button when the right 
edge of the table aligns approximately with the 4 inch mark on the horizontal 
ruler.

The width of the table expands.

The table is now approximately as wide as the tabbed list above, creating a nice balance.

CLEAN UP Save the ConsultationB document, and then close it.

 Presenting Information in Tables  133



134  Chapter 4 Organize Information in Columns and Tables

Performing Calculations in Tables

When you want to perform calculations with the numbers in a Word table, you 
can create a formula that uses a built-in mathematical function. You construct a 
formula by using the tools in the Formula dialog box, which you display by clicking 
the Formula button in the Data group on the Layout contextual tab. 

The Formula dialog box.

A formula consists of an equal sign (=), followed by a function name (such as SUM), 
followed by parentheses containing the location of the cells you want to use for the 
calculation. For example, the formula =SUM(Left) totals the cells to the left of the 
cell containing the formula.

To use a function other than SUM in the Formula dialog box, you click the function 
you want in the Paste Function list. You can use built-in functions to perform a num-
ber of calculations, including averaging (AVERAGE) a set of values, counting (COUNT) 
the number of values in a column or row, or finding the maximum (MAX) or minimum 
(MIN) value in a series of cells.

Although formulas commonly refer to the cells above or to the left of the active cell, 
you can also use the contents of specified cells or constant values in formulas. To 
use the contents of a cell, you type the cell address in the parentheses following the 
function name. The cell address is a combination of the column letter and the row 
number—for example, A1 is the cell at the intersection of the first column and the 
first row. A series of cells in a row can be addressed as a range consisting of the first 
cell and the last cell separated by a colon, such as A1:D1. For example, the formula 
=SUM(A1:D1) totals the values in row 1 of columns A through D. A series of cells in a 
column can be addressed in the same way. For example, the formula =SUM(A1:A4) 
totals the values in column A of rows 1 through 4.



Other Layout Options

You can control many aspects of a table in the Table Properties dialog box, 
which you display by clicking the Properties button in the Table group on the 
Layout tab. You can set the following options:

● On the Table page, you can specify the width of the entire table, as well as the 
way it interacts with the surrounding text.

● On the Row page, you can specify the height of each row, whether a row is 
allowed to break across pages, and whether a row of column headings should 
be repeated at the top of each page. 

Tip The Repeat As Header Row option is available only if the cursor is in the top 
row of the table.

● On the Column page, you can set the width of each column.

● On the Cell page, you can set the width of cells and the vertical alignment of 
text within them.

Tip You can also control the widths of selected cells by changing the settings in 
the Cell Size group on the Layout tab.

● On either the Table page or Cell page, you can control the margins of cells 
(how close text comes to the cell border) by clicking Options and specifying 
top, bottom, left, and right settings.

Tip You can also control the margins by clicking the Cell Margins button in the 
Alignment group on the Layout tab.

● On the Alt Text page, you can enter text that describes what the table is 
about.
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Formatting Tables
Formatting a table to best convey its data can be a process of trial and error. With Word 
2010, you can quickly get started by applying one of the table styles available in the 
Table Styles gallery on the Design contextual tab. 

The table styles include a variety of borders, colors, and other attributes to give the table a  
professional look.

If you want to control the appearance of a table more precisely, you can use the commands 
on the Design and Layout tabs. You can also format the table content. As you saw in the 
previous exercise, you can apply character formatting to the text in tables just as you would 
to regular text, by clicking buttons on the Mini Toolbar. You can also click the buttons in the 
Font group on the Home tab. You can apply paragraph formatting, such as alignment and 
spacing, by clicking buttons in the Paragraph group on the Home tab. And you can apply 
both character and paragraph styles from the Quick Styles gallery.



In this exercise, you’ll first apply a table style to a table. Then you’ll format a table row 
and column. You’ll also apply character and paragraph formatting to various cells so 
that the table’s appearance helps the reader understand its data.

SET UP You need the RepairCosts_start document located in your Chapter04 practice 
file folder to complete this exercise. Open the RepairCosts_start document, and save it 
as RepairCosts. If formatting marks are displayed, hide them, and then follow the steps.

 1. Click anywhere in the table, and then on the Design tab, point to each thumbnail 
in the first row of the Table Styles gallery to see its live preview.

 2. In the Table Style Options group, clear the Banded Rows check box, and select 
the Total Row check box.

The table style thumbnails no longer have banded rows, reflecting your changes.

 3. In the Table Styles group, click the More button.

The Table Styles gallery appears.

 4. Preview all the styles in the gallery. When you finish exploring, click the second 
thumbnail in the fifth row (Medium Shading 2 – Accent 1).

The style needs to be modified to suit the data, but it’s a good starting point.

This table style applies formatting to the header and total rows, the first column, and the 
text of the table.
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 5. Select all the cells in the last row by clicking in the selection area to its left. Then in 
the Table Styles group, click the Borders arrow, and click Borders and Shading.

The Borders And Shading dialog box opens, displaying the borders applied to the 
selected cells.

 6. On the Borders page of the dialog box, scroll to the top of the Style list, and click 
the thick black border. 

 7. In the Preview area, click the top border button once to remove the current border, 
and click again to apply the thick black border.

 8. Click the Shading tab, and click the Fill arrow. Under Theme Colors in the palette, 
click the fifth box in the top row (Blue, Accent 1). Then click OK.

 9. Without moving the selection, on the Home tab, in the Font group, click the Font 
Color arrow, and under Theme Colors in the palette, click the white box. Then 
press Home to release the selection.

The table now has the same border at the top and bottom.

You can customize a table style to meet your needs.

 10. Point to the left side of the Elastomeric Decks cell, and when the pointer changes 
to a black right-pointing arrow, drag downward to select all the cells in the Item 
column except the TOTAL cell. 



 11. On the Design tab, in the Table Styles group, click the Shading arrow, and 
under Theme Colors, click the third box in the blue column (Blue, Accent 1, 
Lighter 40%).

 12. Select all the cells containing amounts in the Cost, $ column, including the cell with 
the total. Then on the Layout tab, in the Alignment group, click the Align Center 
Right button.

Tip If the first row of your table has several long headings that make it difficult to fit the 
table on one page, you can turn the headings sideways. Simply select the heading row 
and click the Text Direction button in the Alignment group on the Layout tab.

Now you can judge how well the table displays its data.

The total now stands out better, and the amounts are easier to read.

Tip If you will need to use this formatted table with different data in the future, you can 
save it as a Quick Table. For information about saving customized tables for future use, 
see the sidebar “Quick Tables” on the next page.

CLEAN UP Save the RepairCosts document, and then close it.
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Quick Tables

With Word 2010, you can create Quick Tables—preformatted tables with sample 
data that you can customize. To create a Quick Table:

 1. On the Insert tab, in the Tables group, click the Table button, and then point 
to Quick Tables.

The Quick Tables gallery appears.

The predefined Quick Tables meet several common needs.

 2. Scroll through the gallery, noticing the types of tables that are available, and 
then click the one you want.

For example, this is the Matrix Quick Table.

The Matrix Quick Table includes row and column headings, placeholder data, and no 
summary data, such as totals.



 3. On the Design tab, apply formatting to tailor the Quick Table to your needs.

For example, here’s the Matrix Quick Table after we formatted it.

It is easy to customize a Quick Table for your own needs.

If you will use the table again, you can save it in the Quick Tables gallery. Select 
the table, display the Quick Tables gallery, and click Save Selection To Quick Tables 
Gallery. Then in the Create New Building Block dialog box, assign a name to the table, 
and click OK. Provided you save the Building Blocks template when Word prompts 
you to, the table will be available in the Quick Tables gallery for future use.

See Also For information about building blocks, see “Inserting Building Blocks” in 
Chapter 5, “Add Simple Graphic Elements.”

Key Points
● To vary the layout of a document, you can divide text into columns. You can 

control the number of columns, the width of the columns, and the space between 
the columns.

● To clearly present a simple set of data, you can use tabs to create a tabbed list, 
with custom tab stops controlling the width and alignment of columns.

● You can create a table from scratch, or convert existing text to a table. You can 
control the size of the table and its individual structural elements.

● By using the built-in table styles, you can quickly apply professional-looking cell 
and character formatting to a table and its contents.

● You can enhance a table and its contents by applying text attributes, borders, and 
shading.
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 7 Insert and Modify 
  Diagrams
In this chapter, you will learn how to
✔ Create diagrams.
✔ Modify diagrams.
✔ Create picture diagrams.

Diagrams are graphics that convey information. Business documents often include diagrams 
to clarify concepts, describe processes, and show hierarchical relationships. Microsoft 
Word 2010 comes with a powerful diagramming tool called SmartArt that you can use 
to create diagrams directly in your documents. By using ready-made diagram templates, 
you can produce sophisticated results tailored to your needs.

In this chapter, you’ll insert a diagram into a document and specify its size and position. 
Then you’ll change the diagram’s layout, visual style, and color theme. Finally, you’ll see 
how to use a diagram to arrange pictures in a document.

Practice Files Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter07 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.

Creating Diagrams
When you need your document to clearly illustrate a concept such as a process, cycle, 
hierarchy, or relationship, the powerful SmartArt Graphics tool is available to help you 
create a dynamic, visually appealing diagram. By using predefined sets of sophisticated 
formatting, you can almost effortlessly put together any of the following diagrams:

● List These diagrams visually represent lists of related or independent information—
for example, a list of items needed to complete a task, including pictures of the items.
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● Process These diagrams visually describe the ordered set of steps required to 
complete a task—for example, the steps for getting a project approved.

● Cycle These diagrams represent a circular sequence of steps, tasks, or events, or the 
relationship of a set of steps, tasks, or events to a central, core element—for example, 
the looping process for continually improving a product based on customer feedback.

● Hierarchy These diagrams illustrate the structure of an organization or entity—for 
example, the top-level management structure of a company.

● Relationship These diagrams show convergent, divergent, overlapping, merging, or 
containment elements—for example, how using similar methods to organize your 
e-mail, calendar, and contacts can improve your productivity.

● Matrix These diagrams show the relationship of components to a whole—for 
example, the product teams in a department.

● Pyramid These diagrams illustrate proportional or interconnected relationships—
for example, the amount of time that should ideally be spent on different phases of 
a project.

● Picture These diagrams rely on pictures instead of text to create one of the other 
types of diagrams—for example, a process picture diagram with photographs 
showing the recession of glaciers in Glacier National Park.

You select the type of diagram you want to create from the Choose A SmartArt Graphic 
dialog box. The categories are not mutually exclusive, meaning that some diagrams ap-
pear in more than one category.

The Choose A SmartArt Graphic dialog box.



After creating the diagram, you insert text by typing either directly in its shapes or in the 
associated Text pane. Depending on the diagram type, the text appears in or adjacent to 
its shapes.

In this exercise, you’ll create a diagram, add text, adjust its size, and specify its position in 
relation to the document text and page margins.

SET UP You need the ServiceA_start document located in the Chapter07 practice file 
folder to complete this exercise. Open the ServiceA_start document, and save it as 
ServiceA. Then follow the steps.

 1. Click to the left of the Gather information heading, and then on the Insert tab, in 
the Illustrations group, click the SmartArt button.

Keyboard Shortcut Press and release Alt, N, and then M to open the Choose A 
SmartArt Graphic dialog box.

See Also For more information about keyboard shortcuts, see “Keyboard Shortcuts” at 
the end of this book.

The Choose A SmartArt Graphic dialog box opens, displaying all the available 
graphics.

 2. In the left pane, click each diagram category in turn to display only the available 
layouts of that type in the center pane.

 3. In the left pane, click Process. Then in the center pane, click each process diagram 
layout in turn to view an example, along with a description of what the diagram best 
conveys, in the right pane.

Tip While you are exploring, keep in mind how much data your own diagrams might 
contain, and analyze which diagrams will ensure that the data will all fit on one page.

 4. When you finish exploring, click the third thumbnail in the sixth row (Vertical 
Process), and then click OK.

The process diagram is inserted at the cursor, and the Design and Format contextual 
tabs are displayed on the ribbon.
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Three text placeholders appear in the diagram shapes and in the adjacent Text pane, where 
the text placeholders are formatted as a bulleted list.

Troubleshooting The appearance of buttons and groups on the ribbon changes depending 
on the width of the program window. For information about changing the appearance of 
the ribbon to match our screen images, see “Modifying the Display of the Ribbon” at the 
beginning of this book.

Depending on your screen resolution, you might see a description of the Vertical 
Process diagram at the bottom of the Text pane. If your Text pane looks like the 
one in our graphic, you can click Vertical Process to display the description.

Troubleshooting If the Text pane is not open, click the tab displaying left and right 
(open and close) arrows on the left side of the diagram frame. You can also display the 
Text pane by clicking the Text Pane button in the Create Graphic group on the Design 
contextual tab.

 5. With the first bullet selected in the Text pane, type Gather information, and then 
press the Down Arrow key to move the cursor to the next placeholder.

Troubleshooting Be sure to press the Down Arrow key. If you press the Enter key, 
you’ll start a new bullet, and if you press the Tab key, you’ll turn the current bullet 
into a level-two bullet below the one above it.

As you type in the Text pane, the words also appear in the corresponding shape in 
the diagram.

Tip For a cleaner look, don’t type any punctuation at the end of the text in diagram 
shapes.



 6. Repeat step 5 for the remaining two placeholders, entering Set up team and Plan 
project.

 7. With the cursor at the end of the third bulleted item in the Text pane, press Enter 
to extend the bulleted list and add a new shape to the diagram. Then type Meet 
with department.

The widths of the shapes in the diagram adjust to accommodate the length of the 
bullet point you just typed.

You can add as many shapes as you need.

 8. In the Text pane, click the Close button.

 9. On the left side of the diagram frame, point to the sizing handle (the four dots), 
and when the pointer changes to a double-headed arrow, drag to the right past 
the diagram and into the white space, until the frame is approximately as wide 
as the shapes within the diagram.

Troubleshooting Ensure that the pointer is a double-headed arrow before dragging. 
Point to the four dots, not to a blank part of the frame or to the Text pane tab on the 
left side of the frame.
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 10. If you can’t see the diagram after you release the mouse button, scroll up in the 
document.

The diagram now sits at the left margin of the document, with the Gather information 
heading to its right.

The diagram is anchored to the Gather information heading and moves with it.

 11. On the Format contextual tab, in the Arrange group, click the Wrap Text button, 
and then in the gallery, click Square.

Troubleshooting Depending on your window size and screen resolution, you might 
need to click the Arrange button to display the Arrange group.

See Also For information about text wrapping, see “Arranging Objects on the Page” in 
Chapter 10, “Organize and Arrange Content.”

 12. In the Arrange group, click the Position button, and then at the bottom of the 
gallery, click More Layout Options.

The Layout dialog box opens with the Position page displayed. On this page are 
options for controlling where the diagram appears relative to other elements of 
the document.



The Position page of the Layout dialog box.

 13. In the Horizontal area, click Alignment. Then click the Alignment arrow, and in 
the list, click Right.

 14. In the Vertical area, click Alignment. Leave the Alignment setting as Top, and 
then change the relative to setting to Line.

 15. Click OK.

Instead of sitting at the left margin with text before and after it, the diagram now 
sits to the right of the text, without interrupting its flow.

 16. In the lower-left corner of the diagram frame, point to the sizing handle. When 
the pointer changes to a diagonal double-headed arrow, drag up and to the right 
until the bottom of the diagram frame sits level with the last line of text in the 
Community Service Committee paragraph.

Tip You can precisely size the diagram by adjusting the Height or Width setting in the 
Size group on the Format contextual tab.

 17. Click a blank area of the document.

The diagram now sits neatly to the right of the introductory text.
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You can align and size the diagram to fit your text.

CLEAN UP Save the ServiceA document, and then close it.

Modifying Diagrams
After you create a diagram, you can add and remove shapes and edit the text of the 
diagram by making changes in the Text pane. You can also customize the diagram by 
using the options on the SmartArt Tools contextual tabs.

You can make changes such as the following by using the commands on the Design 
contextual tab:

● Switch to a different layout of the same type or of a different type.

Tip If you have entered more text than will fit in the new layout, the text is not shown, 
but SmartArt retains it so that you don’t have to retype it if you switch the layout again.

● Add shading and three-dimensional effects to all the shapes in a diagram.

● Change the color scheme.

● Add shapes and change their hierarchy.

Tip You can remove a shape and its text by selecting it and then pressing the Delete 
key. You can also rearrange shapes by dragging them.

You can customize individual shapes in the following ways by using the commands on 
the Format contextual tab:

● Change an individual shape—for example, you can change a square into a star.

● Apply a built-in shape style.



● Change the color, outline, or effect of a shape.

● Change the style of the shape’s text.

You can use Live Preview to display the effects of these changes before you apply them. 
If you apply a change and then decide you preferred the original version, you can click 
the Reset Graphic button in the Reset group on the Design contextual tab.

In this exercise, you’ll change a diagram’s layout, style, and colors. Then you’ll change the 
shape and color of one of its elements, and customize copies of the diagram.

SET UP You need the ServiceB_start document located in the Chapter07 practice file 
folder to complete this exercise. Open the ServiceB_start document, and save it as 
ServiceB. Then follow the steps.

 1. If necessary, adjust your view of the document so that the entire diagram sits in the 
bottom half of your screen.

 2. Click a blank area inside the diagram frame to activate the diagram as a whole.

Troubleshooting Be sure to click a blank area away from any shapes. If a shape in 
the diagram is surrounded by handles, that shape is selected, either for editing or for 
manipulation, instead of the diagram as a whole.

 3. On the Design contextual tab, in the Layouts group, click the More button.

The Layouts gallery appears, showing the other available Process diagram layouts.

You can switch to any of these layouts.
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Tip If a gallery has a sizing handle (three dots) in its lower-right corner, as this one does, 
you can drag the handle upward to reduce the height of the gallery. You can then see 
more of the document and the gallery at the same time.

 4. In the Layouts gallery, point to each thumbnail to preview the diagram with that 
layout.

Because changing the layout does not change the width of the diagram frame, 
some of the horizontal layouts create a very small diagram.

 5. In the Layouts gallery, click the last thumbnail in the fourth row (Basic Bending 
Process).

The diagram changes to two columns with arrows indicating the process flow.

 
The Basic Bending Process diagram.

 6. Point to the sizing handle on the left side of the diagram’s frame, and when the 
pointer changes to a two-headed arrow, drag the frame to the left until the diagram 
occupies a bit less than half the page width.

When you release the mouse button, the shapes in the diagram expand to fill the 
resized frame.

 7. On the Design contextual tab, in the SmartArt Styles group, click the More 
button.

The SmartArt Styles gallery appears.



You can apply two-dimensional or three-dimensional styles.

 8. In the gallery, point to each style, noticing the changes to your diagram. Then 
under 3-D, click the first thumbnail in the first row (Polished).

 9. In the SmartArt Styles group, click the Change Colors button.

The Colors gallery appears, offering sets of different colors or of different shades 
of the same color.

 10. Preview a few color combinations, and then under Colorful, click the first thumbnail 
(Colorful – Accent Colors).

In the document, you can see that the new diagram colors coordinate with the 
text colors.

The diagram shapes have a new style and new colors.
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 11. In the upper-left corner of the diagram, click the Gather information shape (not 
its text), and then on the Format contextual tab, in the Shapes group, click the 
Change Shape button.

The Shapes gallery appears, showing all the available built-in shapes.

You can use any of these shapes in a diagram.

 12. Under Basic Shapes, click the first shape in the first row (Oval).

The selected shape changes from a rectangle to an oval.

 13. Without changing the selection, in the Shape Styles group, click the Shape Fill 
button. Then under Standard Colors in the palette, click the first box (Dark Red).

 14. Click away from the diagram.

You can now see the results.



The shape that corresponds with the heading to the left of the diagram is now accentuated 
with a different shape and color.

 15. Click a blank area within the diagram to select it. Then on the Home tab, in the 
Clipboard group, click the Copy button.

 16. Scroll down the document, click to the left of the Set up team heading, and in the 
Clipboard group, click the Paste button to paste in a copy of the diagram.

 17. On the Format tab, in the Arrange group, click the Position button, and then click 
More Layout Options to display the Layout dialog box. Ensure that the Horizontal 
setting is Alignment, Right relative to Column and the Vertical setting is 
Alignment, Top relative to Line. Then click OK.

 18. Click the Gather information shape (not its text). In the Shapes group, click the 
Change Shape button, and under Rectangles, click the second shape (Rounded 
Rectangle). Then in the Shape Styles group, click the Shape Fill button, and under 
Theme Colors in the palette, click the third box (Light Turquoise, Background 2).

The shape corresponding to the previous heading is now muted to show that it 
has already been discussed.

 19. Click the Set up team shape (not its text), and change its shape to Oval. Then 
change its fill color to Dark Red.

The diagram now corresponds with the adjacent topic.
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The red oval shape reflects the heading to the left, and the previous topic is a muted color.

 20. If you want, repeat steps 15 through 19 to insert a customized copy of the diagram 
adjacent to each of the remaining headings in the Process section.

Tip Sometimes headings appear too close together, or a heading might appear too 
close to the bottom of the page, to accommodate a series of diagrams neatly. In that 
case, insert a page break (press Ctrl+Enter) to push each heading to a new page before 
inserting the diagram.

CLEAN UP Save the ServiceB document, and then close it.

Creating Picture Diagrams
The SmartArt Graphics tool that comes with Word 2010 includes a sophisticated new 
category of diagrams that are designed to hold pictures. You can use these diagrams 
for business uses such as creating organization charts with pictures as well as names 
and titles or for personal uses such as creating a page of family photographs.

In this exercise, you’ll create a page of photographs. You’ll size and position the  
photographs and then enter and format accompanying captions.



SET UP You need the Garden, Park, Pond, and Woods pictures located in the Chapter07 
practice file folder to complete this exercise. Create a blank document, and save it as 
Westbury in the folder where you usually save your practice files. Then follow the steps.

 1. On the Page Layout tab, in the Page Setup group, set the orientation to Landscape, 
and set the margins to Narrow. Then if necessary, set the zoom percentage so that 
you can see the entire page on your screen.

 2. At the top of the document, type Westbury, and press Enter. Select the text, and 
then on the Home tab, in the Font group, click the Text Effects button. Then in 
the gallery, click the second thumbnail in the last row (Gradient Fill - Orange, 
Accent 6, Inner Shadow). Finally, set the size to 72.

 3. Press the Down Arrow key, and on the Insert tab, in the Illustrations group, click 
the SmartArt button. In the left pane of the Choose a SmartArt Graphic dialog 
box, click Picture. Then in the middle pane, double-click the first thumbnail in the 
first row (Accented Picture).

The template for the selected diagram is inserted at the cursor.

The Accented Picture diagram, ready for you to enter pictures and captions.

 Creating Picture Diagrams  217



218  Chapter 7 Insert and Modify Diagrams

 4. Click a blank area inside the diagram frame, and then on the Format contextual tab, 
in the Size group, change the Height setting to 5.75 and the Width setting to 9.

Tip You don’t have to type the inch marks; Word will add them for you. After you enter 
a Size setting, pressing Enter implements your changes.

 5. Click a blank area of the biggest shape, and then in the Size group, change the 
Height setting to 5 and the Width setting to 8. Then drag the shape down and 
to the left until it sits in the lower-left corner of the diagram frame.

 6. Click a blank area of the top circle, and then in the Size group, use the up arrows 
in the Height and Width settings to increase the size to 1.7”. Repeat this step for 
the other two circles.

Troubleshooting Don’t type the sizes; use the arrows. Sometimes the shapes don’t hold 
precise measurements when you type them.

 7. Drag the top circle to the upper-right corner of the diagram frame, drag the 
middle circle to the right to align with the frame, and drag the bottom circle to 
the lower-right corner of the frame.

The diagram now occupies most of the page.

The picture placeholders have been sized and positioned to fit the available space.



	 8.	 In the biggest shape, click the Insert Picture icon.

The Insert Picture dialog box opens.

	 9.	 Navigate to your Chapter07 practice file folder, and then double-click Park.

	 10.	 Repeat step 9 to insert the Garden picture in the top circle, the Pond picture in 
the middle circle, and the Woods picture in the bottom circle.

	 11.	 Open the Text pane, and replace the placeholder bullet points with Park, Garden, 
Pond, and Woods.

The captions appear on the diagram in the position and format specified by the 
diagram template.

The pictures now have captions.

	 12.	 In the Text pane, double-click the Park bullet point, and then on the Home tab, in 
the Font group, apply the Gradient Fill – Orange, Accent 6, Inner Shadow text 
effect and set the size to 40. Repeat this step for the Garden, Pond, and Woods 
bullet points. Then close the Text pane.

	 13.	 To balance the page, on the Page Layout tab, in the Page Setup group, click the 
Margins button, and at the bottom of the gallery, click Custom Margins. Then 
in the Page Setup dialog box, increase the Left margin to 1.25, and click OK.

Troubleshooting	 If	Word	displays	a	message	that	one	of	the	margins	is	outside	the	
printable	area	of	the	page,	in	this	case	you	can	click	Ignore.	If	you	were	going	to	print	
this	page,	you	would	want	to	fix	the	problem.
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	 14.	 Make any additional adjustment to achieve a balanced page.

We indented the title by 1 inch and removed the space after it.

The final picture diagram.

CLEAN UP	 Save	the	Westbury	document,	and	then	close	it.



Key Points
● You can easily create a sophisticated diagram to convey a process or the relationship 

between hierarchical elements.

● Diagrams are dynamic illustrations that you can customize to produce precisely the 
effect you are looking for.

● You can use a picture diagram to neatly lay out pictures on a page.
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A
absolute positioning, 273, 277
Accept button, 390, 392, 395
accepting revisions, 390, 392

all in document, 395
accessibility, checking, 195
activating blogs in Word, 300
active document, closing, 25
add-ins, 428, 430, 431
Add-Ins dialog box, 431
address lists, e-mail. See e-mail mail merging
Add Template dialog box, 421
advanced options, 426
Align button, 278
Align Center button, 131
Align Center Right button, 132, 139
Align gallery, 278
aligning diagrams, 209, 215
aligning objects, 278
aligning text, 97-98, 101-102

around objects, 273
around pictures, 145
in tables, 131, 132, 139
with tab stops, 97

alt text in tables, 135
anchoring text to objects, 273
Apply Styles dialog box, 410
Arrange All button, 36
arranging stacked objects, 273, 280
arrows on buttons, 7
Artistic Effects button, 149
aspect ratio, 441
Attach File button, 383
attaching templates, 408, 420
attachments, e-mail. See also e-mail messages

inserting, 383
sending documents as, 382

Attach Template dialog box, 420
attributes, 441
authenticating documents, 384, 482
author name, viewing, 196
authors. See sources

AutoCorrect
adding to list, 67
fixing spelling errors with, 64-65
options, setting, 65, 424

AutoCorrect dialog box, 65, 112
AutoFormatting options, 112
AutoRecover

customizing settings for, 19
options, setting, 424

AutoText for user name/initials, changing, 166

B
Back button (Help), xxvii
backgrounds

appropriate use of, 152
color, applying, 152
gradients, applying, 153
overview of, 144
pictures as, applying, 155
textures, applying, 154

Backspace key, 40
Backstage view, 5, 14, 184, 193

displaying, 16
Help page, 15
Info page, 14
New page, 15
opening documents from, 23
Print page, 15
Recent page, 14
Share page, 15

balloon comments
balloons for, 441
defined, 441
deleting, 385, 387
displaying, 386
displaying all text, 385
editing, 385
from specific reviewer, hiding, 385
hiding, 385
highlighting, 386
inserting, 385, 386

Index



balloon comments (continued)
navigating, 385, 386
nesting, 385
responding to, 385, 387
reviewer’s name, displaying, 385, 386

balloons. See ScreenTips
banded rows in tables, 137
bar charts, 441
bibliographies

compiling, 347
inserting, 353
overview of, 347
updating, 348

Bibliography button, 347
Bibliography gallery, 352
bilingual dictionary

overview of, 59
translating text with, 63

blank documents, creating, 17
Blank Page button, 159
blank pages, inserting, 159
blocking content, trusted locations for, 429
Blogger service, 300
blog posts

creating, 17
defined, 445
overview of, 299
publishing, 304-305
saving, 304

blogs, 441
activating in Word, 300
addresses for, 303
creating, 299
drafts, opening, 305
e-mail publishing, turning on, 301
home page, navigating to, 305
on Windows Live Spaces, creating, 300, 302
overview of, 299
picture upload options, 303
posting to, 303
publishing documents as posts, 299
publishing posts, 305
publishing posts as drafts, 304
registering accounts, 299, 302
saving posts, 304
service providers, 300
setting up, 299, 300
Web links, adding, 304

Bold button, 89, 124, 422
bolding text, 89
book features and conventions, xix
booklets, printing, 184
Bookmark button, 323

Bookmark dialog box, 323
bookmarks

displaying, 324
hiding, 327
inserting, 323
jumping to, 322, 324-325
overview of, 309, 322
spaces in names, 324

Border button, 99, 104, 284
borders. See also page borders

3-D, 104
adding, 99, 100, 104
cell, 138
table, 284

Borders And Shading dialog box, 100, 104, 
138, 157

Borders button (tables), 138
bound documents, previewing, 185
breaks. See column breaks; page breaks; line 

breaks; section breaks
Breaks button, 96, 101, 122, 192
brightness, adjusting, 147
Browse By Page button, 28
browsers

opening Web pages in, 298
previewing documents in, 29, 34
setting for Web pages, 295
specifying, for Web pages, 294

browsing objects, 27
building blocks. See also header/footers; 

Quick Parts
cover pages, 159, 162
creating, 70, 170
defined, 69, 441
deleting, 161
entering in existing text, 72
gallery of, 160, 166
inserting, 70
keyboard shortcuts for, 70
overview of, 69, 144
page numbers, 159, 165, 166
properties, viewing, 161
saving, 71
in templates, 408
text boxes, 159, 167, 172

Building Blocks Organizer, 160, 166
Building Blocks template, 408
bulleted lists. See also lists

bullet symbol, changing, 107, 109
bullet symbol, live preview of, 109
creating, 107-108
in diagrams, adding to, 207
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bullet points
merging, 47
selecting, 45

Bullets button, 107, 108
buttons. See also specific button names

adding to Quick Access Toolbar, 438
arrows on, 7
inactive, 10
ScreenTips for. See ScreenTips
separator between, 438
viewing information on. See ScreenTips

C
calculations in tables, 134
capital letters. See uppercase
Caption dialog box, 338
captions, 441
case formatting, 94-95
Cell Margins button, 135
cells

addresses, 441
borders around, 138
defined, 441
deleting, 129
inserting, 129
merging, 129, 131
setting width of, 135
shading, 138
splitting, 130

Center button, 101, 105, 119, 165, 174
centering text, 97-98, 101, 119

with Click And Type, 97
in header/footers, 165
keyboard shortcut for, 97, 119
in tables, 131
in WordArt objects, 174

Center Tab button, 124
Change Colors button, 213
Change Shape button, 214, 215
Change Styles button, 77, 80, 412, 421
change tracking

in balloons, 389-390, 392
final version, displaying, 392
options, setting, 389
toggle button, adding, 388
turning off, 393
turning on, 388, 390
user information, changing, 389

character formatting. See also fonts; 
paragraph styles

appropriate use of, 95
attributes, 441
bolding, 89
case, 94
clearing, 94
copying, 90
defined, 441
underlining, 89

characters, non-printing. See formatting marks
character spacing, 87

changing, 93
defined, 441

character styles, 76, 411. See also Quick Styles
defined, 441
finding/replacing, 106

chart area, 441
chevrons, 363, 441
Choose A SmartArt Graphic dialog box, 204, 

205, 217
citations. See also sources

inserting, 339, 350
style guide, setting, 348

Clear Formatting button, 94
clearing formatting, 94
Click And Type

centering text with, 97
defined, 441

clip art. See also pictures
inserting, 144, 150
saving, 150
searching for, 150

Clip Art button, 144, 150
Clipboard, 42

closing, 48
defined, 441
deleting items from, 48
options for, 48
viewing, 48

Clipboard dialog box launcher, 48
Close button, xxix, 4, 25
Close Header and Footer button, 166, 192
Close Outline View button, 272
closing Clipboard task pane, 48
closing documents, 25, 28
closing Word 2010, 4
co-authoring documents, 380
collaborating on documents, 380
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Collapse button, 270
collapsing outlines to single level, 269
collating printed documents, 193
Color button, 147
Color gallery, 147
coloring backgrounds. See backgrounds
coloring pictures, 147
colors, for revision marks, 389
color saturation, 446
color, user interface, 423
column breaks, 116

defined, 441
inserting, 122

column charts, 441
column headings, 441
columns, 115. See also table columns

applying to entire document, 117
defined, 441
formatting, 116
hyphenating text in, 117, 121
indenting text in, 121
justifying, 117, 118
margins, 119
overview of, 116
section/column breaks in, 116, 118
separated by tab stops. See tabbed lists
spacing, changing, 120

Columns button, 117
Columns dialog box, 120
Columns gallery, 116-117
Combine Documents dialog box, 393
combining documents. See merging documents
commands from previous versions, adding, 6
comments

balloons for, 441
defined, 441
deleting, 385, 387
displaying, 386
displaying all text, 385
editing, 385
from specific reviewer, hiding, 385
hiding, 385
highlighting, 386
inserting, 385, 386
navigating, 385, 386
nesting, 385
responding to, 385, 387
reviewer’s name, displaying, 385, 386

Compare button, 393

comparing documents
by combining, 393-394
overview of, 393
viewing results of, 394

compatibility, checking, 195, 298
Compatibility Checker, 298
Compatibility mode, 22
Compatibility Mode, 406
compatibility with earlier versions of Word, 22
Confirm Password dialog box, 397
contacts (Outlook), mail merging, 363
contrast, adjusting, 147
Convert button, 22
converting documents

to .docx format, 22
to Web pages, 427

converting tables to text, 128
converting text to tables, 128, 132
Convert Text To Table dialog box, 132
Convert To Text button, 128
Copy button, 42, 46, 215, 284
copying character formatting, 90
copying diagrams, 215
copying formatting, 90, 149
copying pictures, 149
copying tables, 284
copying text

with Copy button, 42
vs. cutting, 43
keyboard shortcut for, 43
in selection, 42

Corrections button, 147
Cover Page button, 161
cover pages, 159, 162
Create button, 18
Create New Building Block dialog box, 70, 170
Create New Style From Formatting dialog box, 

413, 417
Create PDF/XPS button, 290
Create Source dialog box, 348
creating documents with templates, 406
Crop button, 146
cropping pictures, 146
Cross-reference button, 325
Cross-Reference dialog box, 325
cross-reference entries, 441
cross-references

inserting, 325, 326
jumping to, 326
overview of, 309, 322
updating, 326
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cursor
defined, 441
function of, 16
keyboard shortcuts for, 24-25, 27
moving to beginning of line, 27
moving to end of line, 27
paging up or down with, 24
placing, 24
status bar display for, 24

Custom DPI Setting dialog box, xvii
Customize Keyboard dialog box, 449
Customize Quick Access Toolbar button, 438
Customize Ribbon page, 431, 433
customizing ribbon, 433, 438
custom keyboard shortcuts, 449-450
Cut button, 42, 46, 169
cutting text, 42, 46, 169

keyboard shortcut for, 43, 169
vs. copying, 43

cycle diagrams, 204, 442

D
data markers, 442
data points, 442
data series, 442
data source (charts), 442
data source (mail merge)

creating in outside program, 357
editing, 360
for e-mail addresses, 372
field names in, 356, 357
filtering, 357, 361
Outlook contacts list as, 363
overview of, 356
queries for, 357
recipients, adding, 360
selecting, 358
sorting, 357, 361
subset, merging from, 357

date and time
automatic updating, 319
automatic updating, turning off, 318
as field, vs. as text, 317
inserting, 317, 319
updating, 317

Date And Time dialog box, 318
Date & Time button, 317, 318
decimal alignment, 97, 103
Decimal Tab button, 103

Decrease Indent button, 96, 105
default font, 87
Delete button (tables), 129
Delete Comment button, 387
Delete key, 40
deleting building blocks, 161
deleting comments, 387
deleting keyboard shortcuts, 451
deleting page/section breaks, 190
deleting styles, 413
deleting table rows/columns/cells, 129
deleting tab stops, 98
deleting text, 40, 42, 44, 47
Demote button, 270
demoting outline headings, 270, 442
deselecting text, 42
desktop publishing, 442
destination files, 442
Developer tab, 420
diagrams. See also SmartArt graphics

aligning, 209, 215
in bulleted lists, 207
colors, changing, 213
copying, 215
creating, 204, 205
defined, 442
entering text, 206
gallery of, 211
inserting text, 205
layout, changing, 210, 212
pasting, 215
positioning on page, 208, 215
punctuation in, 206
resetting to original, 211
selecting, 211, 215
shapes, changing, 214-215
shapes, deleting, 210
shapes, selecting, 211
sizing, 207, 209, 218
text overflow, 210
Text pane, opening, 206
text placeholders in, 205-206
text wrapping, 208
types of, 203-205

dialog boxes. See also specific dialog boxes
closing, 12
displaying, 7
help with, xxv

dialog box launcher, 7, 442
dictionaries, bilingual, 59, 63
digital signatures, 384, 442
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directory paths, 445
display settings different from book, xviii
distributing documents

electronically, 195
in XPS format, 199

dividing cells, 130
.doc format, 289
document format, setting default, 424
document headings

navigating to, 28
tables of contents based on, 332

document history, 14
Document Inspector, 195, 197
document navigation keyboard shortcuts, 54
document outlines. See outlines; Outline view
document properties

displaying, 14 
inserting as fields, 319
inserting in fields, 318
viewing, 195-196

document review. See revisions; tracking 
changes

documents
blank, creating, 17, 19
closing, 28
closing, while leaving Word running, 25
compatibility with earlier versions, 22
creating, 16, 19
creating from existing, 17
formatting in columns, 117. See also columns
full-screen display, 29, 33
inserting in other documents, 73
maximizing, 36
moving to top of, 31
navigating, 24, 32, 34, 47
opening, 23, 26
outlines, viewing, 29
read-only, opening as, 24
recently opened, 14, 23
renaming when saving, 20
repairing, 24
saving, 18, 20
saving, as earlier version, 22
saving, creating folders for, 19
saving, creating folders when, 20
saving, in new location, 19, 21
saving, renaming when, 20
scrolling through, 24, 27
selecting, 41, 296
sharing. See sharing documents
side-by-side display, 32
splitting into two panes, 30

switching between, 30, 35
translating, 60
viewing multiple, 36
views for. See views
zooming in/out, 30

document statistics, 69
document summaries, viewing, 197
document templates

applying, 414
attaching, 408, 420
building blocks in, 408
Building Blocks template, 408
Compatibility Mode, 406
components of, 407-408
creating, 408
creating documents with, 406
default, 406
defined, 447
displaying, 15
downloading, 406
file name extensions, 408
global, 408, 421
graphic elements, 407
macros in, 408
Normal template, 406, 408-409
opening, 419
organizing, 416
placeholders in, 407
previewing, 18
recently used, 17
sample, installed with Word, 17, 406
saving, 408
saving documents as, 415
searching for, 18
switching, 420

Document Themes folder, 83
document title, inserting as field, 319
.docx format, 22, 288
.dotm format, 408
.dotx format, 408
downloading practice files, xxi
downloading templates, 406
dpi settings, xvii
Draft button, 35
drafts, publishing blog posts as, 304
Draft view, 29, 442
drag-and-drop editing, 42, 47, 442
dragging objects, 442
drawing grid

positioning objects with, 273
turning off, 280
turning on, 279
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Drawing Grid dialog box, 278
drawing objects

absolute positioning, 277
alignment options, 278
defined, 442, 444
hiding, 282
overview of, 143
positioning, 273-274
positioning with grid, 279
sending backwards in stack, 280
wrapping text around, 274

drawings. See diagrams; pictures
drawing tables, 127, 282, 283. See also tables
drawing text boxes, 172
Drop Cap dialog box, 178
drop caps

defined, 442
inserting, 178

duplex printing, 193

E
earlier Word versions, saving files for, 289
Edit Data Source dialog box, 360
Edit Hyperlink dialog box, 314
editing, drag-and-drop, 42, 47, 442
editing comments, 385
editing documents

after finalizing, 199
in Full Screen Reading view, 29
multiple editors on. See revisions; tracking 

changes
restricting, 401, 402

editing hyperlinks, 314
editing sources, 349
editing text

drag-and-drop, 42, 47, 442
tracking. See revisions; tracking changes
undoing, 43-44, 46

Edit Name dialog box, 349
effects, text

applying, 77, 81, 92
defined, 443
live preview of, 81

efficiency, improving, 5
e-mail hyperlinks, 313
e-mailing documents, 381

as attachments, 382
as PDF files, 382
as XPS files, 382

e-mail mail merging, 370
options, setting, 374
previewing, 373
selecting recipients, 371-372

e-mail messages. See also attachments, e-mail
formatting text, 383
greeting lines, inserting, 372
importance, setting, 383
merge fields, inserting, 371, 372
sending, 384

embedded fonts, 425
embedded objects, 442
Encrypt Document dialog box, 399
encrypted password protection, 396, 399
encrypting documents, 399
endnotes

defined, 442
formatting, 330

entering text, 19, 40
Enter Text dialog box, 297
Envelope Options dialog box, 370
Envelopes And Labels dialog box, 370
Envelopes button, 370
envelopes, printing, 370
errors, fixing

with AutoCorrect, 64-65
with shortcut menu, 64, 66
with Spelling and Grammar dialog box, 64
flagging of, 20

exercise format, xviii
exiting Word 2010, 4
Expand button, 270
Expand button (Mini Translator), 63
expanding outline headings, 270
expanding ribbon, 7, 438
Expand The Ribbon button, 7
Extensible Markup Language (XML), 442
extensions, file name. See also file formats

.docx, 22

.dotm, 408

.htm, 294

.rtf, 289

.txt, 289 
for templates, 408

F
fancy effects. See WordArt objects
faxing documents, 382
features and conventions of book, xix
Field dialog box, 316, 321
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field names, 443
Field Options dialog box, 316
fields. See also merge fields

code display, toggling, 317
components of, 316
date or time, inserting, 317
defined, 316, 442
for document properties, 318
inserting, 316
locking, 318
options, setting, 316
overview of, 309, 316
switches, 316
syntax, displaying, 316
updating, 317-320

file formats, 443. See also file name extensions
changing, 290
default, 288, 424
Plain Text, 289
Rich Text Format, 289
saving as, 425
saving documents in different, 288
Single File Web Page, 294
Web Page, Filtered, 294

file locations, specifying, 427
file name extensions, 20. See also file formats

.docx, 22

.dotm, 408

.htm, 294

.rtf, 289

.txt, 289
for templates, 408

files, inserting in documents, 73
File tab, 14
Fill Effects dialog box, 152
Filter And Sort dialog box, 360
filtering, 443
filtering mail merge data sources, 357, 361
finalizing documents, 195, 199
Find And Replace dialog box, 51

Go To tab, keyboard shortcut for, 322
Replace tab, displaying, 52

Find button, 49, 52, 322
finding/replacing formatting, 106
finding text, 49, 52. See also Navigation task 

pane
advanced options for, 50, 53
in bilingual dictionary, 59
keyboard shortcut for, 49
matching case when, 51
and replacing, 51, 54
ScreenTips with page numbers for, 50
search direction, specifying, 51

sound-alikes, 51
wildcards in searches, 51, 447

Finish & Merge button, 373
first line indent, 96
First Record button, 376
folder paths, 445
folders, creating when saving documents, 19, 20
Font button, 90
font color, 87, 93
Font Color button, 93
Font dialog box, 88, 92
font effects

applying, 77, 81, 92
defined, 443
live preview of, 81

Font gallery, 90
fonts. See also character formatting

applying, 91
attributes for, 87
available, 87
default, 87
defined, 75, 443
embedding, 425
in themes, changing, 85

font size, 87
changing, 92
defined, 443
incrementing, 92
keyboard shortcuts for adjusting, 92

font style, 87, 443
Footer button, 318
footers. See header/footers
Footnote And Endnote dialog box, 330
footnotes

defined, 443
formatting, 330

foreign languages, specifying, 426
Format Painter button, 90, 149
format previewing. See Live Preview
formats, setting default, 424
formatting. See also styles; themes 

automatically. See AutoFormatting options
copying, 149
restricting, 401-402
saving style from, 413
selecting similar, 331

formatting, finding/replacing, 106
formatting marks

displaying, 30
hiding, 33
keyboard shortcut for, 44
section break indicator, 190, 192
showing/hiding, 44, 125
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formatting option thumbnails, 9
Formatting Restrictions dialog box, 401
formatting tables, 136
formatting text in columns, 116
form letters. See main document (mail merge)
Formula button, 134
Formula dialog box, 134
formulas in tables, 134

constructing, 134
defined, 443
referencing cells in, 134

Forward button, 34
Forward button (Help), xxvii
frequently misspelled words, correcting, 64
Full Screen Reading button, 33
Full Screen Reading view, 29, 33, 443
functions, constructing, 134

G
galleries

building blocks, 441
closing without making selection, 12
defined, 443
of formatting thumbnails, 9
sizing handles, 212

General Options dialog box, 396
global templates, 408, 421
Go To Footer button, 165
grammar checker, 67. See also checking spelling
graphics. See building blocks; diagrams; drawing 

objects; pictures; SmartArt graphics
grayed-out buttons, 10
grayscale, 443
Greeting Line button, 372
grid

positioning objects with, 273
turning off, 280
turning on, 279

gridlines, chart, 443
grouping shapes, 443
groups, ribbon, 443
Grow Font button, 92
guillemet characters, 363, 441

H
hanging indent

adjusting, 102
in columns, adjusting, 121
defined, 96

Header button, 164, 192
header/footers

centering text in, 165
closing, 166, 192
defined, 443
different first page, 192
editing, 192, 318
hiding, 31
inserting, 164
moving to, 165
navigating between, 164
overview of, 159
settings inheritance, 159, 192

headings
navigating to, 28
tables of contents based on, 332

Help button, xxv, xxvi, 7, 447
Help page of Backstage view, 15
Help window

navigating, xxvii
opening, xxvi
printing from, xxviii
searching, xxviii
table of contents, displaying, xxvii
topics, displaying, xxvi

hidden characters, displaying, 30
hidden formatting marks, displaying, 44
hidden text, 30, 195, 342
hiding bookmarks, 327
hiding comments, 385
hiding formatting marks, 33, 125
hiding headers/footers, 31
hiding Mini Toolbar, 423
hiding objects, 282
hiding revisions, 389, 392
hiding ribbon commands, 7
hiding text, 30, 342
hierarchy diagrams, 204, 443
High Importance button, 383
highlighting comments, 386
highlighting text. See also selecting text

color selection for, 93
removing highlighting, 94

Highlight Merge Fields button, 373
home page, blog, 305
Home Page button, 305
Home tab, 9
horizontal scroll bar, 24
HTML format, 294. See also Web pages
HTML (Hypertext Markup Language), 443
HTML tags, 293, 446
Hyperlink button, 310
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hyperlinks, 309
appearance of, 310, 312
in blog posts, 304
deleting, 310
editing, 310, 314
for e-mail addresses, 313
following, 312
inserting, 310
jumping to target, 310, 312
opening in new window, 312
ScreenTips for, 312, 314
targets, setting, 310, 311

Hypertext Markup Language (HTML), 443
hyphenating text

in columns, 117, 121
defined, 443

Hyphenation button, 121

I
images. See pictures
importance, setting in e-mail messages, 383
inactive buttons, 10
Increase Indent button, 96, 102, 109, 124
indentation, Web page, 296
indenting columns, 121
indenting lists, 108, 109
indenting paragraphs, 96, 102
indent markers, 96

defined, 443
moving, 102

Index dialog box, 345
index entry fields

defined, 444
deleting, 342, 346
displaying, 341
editing, 340, 342-343
inserting, 340
marking, 342
selecting, 342

indexes. See also tables of contents
constructing, 340, 341
cross-references in, 340-341, 344
defined, 444
editing, 342, 346
formatting, 340, 342, 345
inserting, 342, 345
marking all instances of word, 343
marking entries, 340, 342
overview of, 329, 340

subentries, marking, 344
updating, 342, 346

Info page of Backstage view, 14
information bar. See status bar
initials

AutoText for, changing, 166
setting, 423

Insert Above button, 129
Insert Address Block dialog box, 364
Insert Below button, 129, 131
Insert Cells dialog box, 129
Insert Citation button, 350
Insert File dialog box, 383
Insert Greeting Line dialog box, 365, 372
Insert Hyperlink dialog box, 310, 311
Insert Index button, 342, 345
inserting text, 40
Insert Left button, 129
Insert Merge Field dialog box, 366
Insert Picture dialog box, 145, 219
Insert Right button, 129
Insert tab, 10
Insert Table dialog box, 126
Insert Table gallery, 126
inspecting documents. See Document Inspector
installing add-ins, 430
international languages, specifying, 426
Internet faxes, sending documents as, 382

J
Justify button, 101, 118
justifying text, 97, 101

in columns, 117, 118
defined, 444
keyboard shortcut for, 97, 118

K
Keep Text Only button, 63
keyboard shortcuts, 449

creating, 449, 450
defined, 444
deleting, 451
for bolding text, 89
for building blocks, 70
for centering text, 97, 119
for clearing formatting, 94
for copying text, 43
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for cursor placement, 25, 27
for cutting text, 43, 169
for demoting outline headings, 270
for document navigation, 47, 54
for expanding outline headings, 270
for finding text, 49
for Font dialog box display, 92
for font size, 92
for formatting marks, 44
for Go To function, 322
for inserting page breaks, 191
for inserting SmartArt graphics, 205
for justifying text, 97, 118
for left-aligning text, 97
for line breaks, 97
for moving outline headings, 271
for navigation, 31
for pasting text, 43
for printing, 184
for repeating editing, 43, 122
for replacing text, 52, 106
for Research task pane, 55
for right-aligning text, 97
for selecting all, 41, 118
for selecting documents, 296
for underlining text, 89
for undoing editing, 43
moving cursor with, 24

keywords, adding, 197
Knowledge Base, xxix

L
Label Options dialog box, 375
labels, mailing. See also mail merge

address blocks, inserting, 376
creating, 374
merge fields for, 374, 376
previewing, 376
printing, 377
recipients, selecting, 375
vendor, selecting, 375

Landscape orientation, 184, 444
languages, specifying additional, 426
languages, translating

entire documents, 60
options for, 62

Layout dialog box, 176, 208, 215, 274, 277
Layouts gallery, 211
left-aligning text, 97
left indent, 96, 102
Left Tab button, 102

legacy commands, 6, 433
legacy compatibility, 22
legacy Word versions, saving files for, 289
legal citations, 339
Line And Paragraph Spacing button, 98, 337
line breaks

defined, 444
inserting, 96, 101
keyboard shortcut for, 97

line graphs, 444
lines, selecting, 41, 79
line spacing, for pictures, 145
Line Spacing button, 103
linked objects, 444
linked styles, 411
linking text boxes, 172
linking within documents. See hyperlinks
links. See hyperlinks
list diagrams, 203, 444
lists. See also tabbed lists

converting text into, 107, 108
ending, 107
indenting, 108, 109
modifying, 107
multiple levels, 107, 111
overview of, 106
sorting, 107, 111
undoing formatting of, 107

Live Preview, 9, 423, 444
locking fields, 318

M
machine translator, 60
macros, 30
macros, template, 408
magnification, adjusting, 30, 78

globally, xvi
to full page, 152
by percentage, 33
to view multiple pages, 32, 185

mailing address, setting, 370
mailing labels. See also mail merge

address blocks, inserting, 376
creating, 374
merge fields for, 374, 376
previewing, 376
printing, 377
recipients, selecting, 375
vendor, selecting, 375

Mailings tab, 13
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mail merge, 444. See also data source (mail 
merge); main document (mail merge)

for e-mail, 370-371, 374
from Outlook contacts list, 363
main document, selecting, 358
to new document, 369
overview of, 356
previewing, 367, 368
recipients, excluding, 369
recipients, selecting, 371, 372
setting up, 358

Mail Merge Recipients dialog box, 359
mailto links, 313
main document (mail merge), 356, 444

address block, inserting, 364
greeting lines, inserting, 365
highlighting merge fields, 373
overview of, 363
saving as normal document, 364
saving before merging, 364
selecting, 358
setting up, 365

Manage Sources button, 348
manual page breaks, 444
margins

changing, 182, 184, 187, 192
of columns, 119
defined, 444
gallery of, 185
mirroring, 186
specifying, 95
in tables, 135

Margins button, 11, 95, 192, 219
Mark Citation dialog box, 339
Mark Entry button, 340, 342
Mark Index Entry dialog box, 340, 343
marking documents as final, 199
marking index entries, 340, 342

all instances of word, 343
as subentries, 344

markup
displaying, 386
hiding, 385

mass e-mails. See e-mail mail merging
master documents, 269
mathematical functions in tables. See formulas 

in tables; functions
matrix diagrams, 204, 444
Maximize button, 36
maximizing documents, 36
Merge Cells button, 129, 131, 132

merge fields, 356, 363, 444
editing, 366
in e-mail messages, 371, 372
highlighting, 373
inserting, 364, 365, 366
in mailing labels, 374, 376

Merge List button, 46
Merge To E-Mail dialog box, 373
Merge To New Document dialog box, 369
Merge To Printer dialog box, 377
merging addresses. See mail merge
merging bullet points, 47
merging cells in tables, 129, 131
merging documents, 393-394

hiding revisions by specific reviewer, 395
viewing results of, 394

Microsoft Knowledge Base, xxix
Microsoft Office Clipboard, 444
Microsoft Office Online Web site themes, 83
Microsoft Product Support Services, xxix
Microsoft SharePoint, 424
Microsoft Translator service, 60
Microsoft Word 2010

closing, 4
compatibility with earlier versions, 22, 289
first time starting, 9
new features in, x
starting, 4, 9
upgrading to, x, xi
uses for, ix

Microsoft Word Help button, xxv, xxvi
Minimize button, 4
Minimize The Ribbon button, 7
minimizing documents, 4
minimizing ribbon, 7
Mini Toolbar, 41

character formatting with, 87
hiding, 423

Mini Translator, 58, 60
mirroring margins, 186
misspellings. See spelling errors, fixing
Modify Style dialog box, 412
More button, 211
Move Up button, 271, 434
moving tables, 128-129
Multilevel List button, 107

N
name and initials, entering, 9
naming documents, 20
navigating comments, 385, 386
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navigating documents, 47
navigating tables, 128
navigating revisions, 389, 392
Navigation task pane, 53. See also finding text

defined, 444
displaying, 19. 28
editing while open, 50
Search tab, displaying, 49

nested tables
creating, 282, 284
defined, 444
formatting, 282
worksheet data as, 284

New Address List dialog box, 371
New Blog Account dialog box, 302
New Comment button, 385, 386
New dialog box, 415
New Folder button, 19, 20, 416
New page of Backstage view, 15
New Style button, 413
New Windows Live Spaces Account dialog 

box, 302
Next Comment button, 386
Next Page button, 24, 27, 32
Next Revision button, 392
non-printing characters. See formatting marks
Normal template, 406, 408-409
notes. See comments
note separators, 444
numbered lists. See also lists

creating, 107, 109
numbering value, setting, 110
number style, changing, 108
restarting numbering, 109

Numbering button, 107, 109

O
objects, drawing

absolute positioning, 277
alignment options, 278
defined, 442, 444
hiding, 282
overview of, 143
positioning, 273-274
positioning with grid, 279
sending backwards in stack, 280
wrapping text around, 274

Office.com Web site templates, 406
online bilingual dictionary, 59, 63

Open dialog box, 23
opening documents, 26

from Backstage view, 23
as read-only, 24
from Recent page, 23
from Windows, 23

opening Web pages, 298
opening Word 2010, 4, 9
Options dialog box, 292
orientation, page

changing, 182, 184
defined, 444

orphans
defined, 188, 444
setting options for, 188, 191

Outline button, 34, 269
outlines

collapsing, 269
creating, 268
demoting headings, 270
displaying, 269
expanding headings, 270
moving headings in, 271
promoting headings, 271

Outline view, 29
closing, 272
defined, 444
displaying, 269
symbols in, 268

Outlining tab, 34
Outlook contacts list, mail merging from, 363
overwriting documents when saving, 19

P
page borders, 157
Page Borders button, 157
Page Break button, 191, 335
page breaks

deleting, 190
inserting, 188, 335
keyboard shortcut for, 191
manual, 444
soft, 188, 446

Page Color button, 12, 152
page colors, previewing effects of, 12
page layout, with tables, 282
Page Layout tab, 10
page length, defining. See margins
Page Number button, 165
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page numbers, 159
formatting, 166
inserting, 165

page orientation
changing, 182, 184
defined, 444

Page Setup dialog box, 11, 182, 184, 219
pages, jumping to, 323
pagination

automatic, 188
paragraph settings, 188, 191
widows and orphans, 188

paper size , 182, 184
Paragraph dialog box, 188, 190, 296

opening, 99
tab alignment, 98

paragraph formatting
aligning, 96-98, 101-102
borders, 99-100, 104
creating styles from, 417
defined, 95, 445
saving as style, 413
shading, 104

paragraph marks, 33. See also formatting marks
paragraphs

aligning, 97
defined, 444
first letter, formatting, 178
indenting, 96
keeping lines together, 191
keeping with next, 188
overview of, 95
selecting, 41, 47
spacing, changing, 98, 103, 124
width, defining. See margins

paragraph styles, 76, 411. See also character 
formatting; Quick Styles

defined, 445
finding/replacing, 106

Password dialog box, 398
password protection

choosing passwords, 397
entering password, 398
read-only documents, opening, 398
removing, 399
setting up, 397
unencrypted vs. encrypted, 396

Paste All button, 48
Paste button, 42, 46, 215
Paste Options button, 43

pasting diagrams, 215
pasting text, 42, 46

from Clipboard pane, 48
keyboard shortcut for, 43
options for, 46
without formatting, 167

paths, 445
PDF files

creating, 290
optimizing size, 290
options for, 290
saving documents as, 290
sending documents as, 382

permissions, restricting, 400
Permissions dialog box, 400
personal information, clearing, 195, 198
photographs. See pictures
Picture button, 144, 145
picture diagrams, 204, 445

entering text, 219
inserting, 217
inserting pictures in, 219
overview of, 216

Picture Options dialog box, 303
pictures. See also clip art

artistic effects, adding, 149
aspect ratio, 441
as backgrounds, 155
brightness, adjusting, 147
captions, 441
contrast, adjusting, 147
copying, 149
copying formatting between, 149
correcting, 147
cropping, 146
defined, 445
incomplete display, 145
inserting, 144-145, 149
inserting in diagrams. See picture diagrams
and line spacing, 145
modifying, 144
overview of, 143
recoloring, 147
resizing, 146
styles, applying, 148
text alignment around, 145
troubleshooting, 145
uploading to blogs, 303

Picture Styles gallery, 148
pie charts, 445
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placeholders, template, 407
Plain Text format, 289
plot area, chart, 445
pointing, 445
points (unit of measure), 445
popup tips. See ScreenTips
Portable Document Format (PDF) files

creating, 290
optimizing size, 290
options for, 290
saving documents as, 290
sending documents as, 382

Portrait orientation, 184, 445
Position button, 174, 208, 215, 276
Position gallery, 273
positioning diagrams, 208
positioning objects, 274

absolute vs. relative, 273
with drawing grid, 273, 279
manually, 273
stacked, 273

posts, blog. See also blogs
creating, 17
defined, 445
overview of, 299
publishing, 304-305
saving, 304

ppi settings, xvii
practice files, xxi
preformatted tables. See Quick Tables
previewing color effects, 12
previewing documents, 183-184

as bound, 185
navigating when, 186
in Web browsers, 29, 34

previewing formats. See Live Preview
previewing mail merge, 367, 368
previewing styles, 410
previewing table styles, 137
previewing templates, 18
Preview Results button, 373
Previous Page button, 24
Previous Record button, 368
Previous Screen button, 34
Print button, 193, 194
printers

settings, changing, 193
status, viewing, 194
switching, 194

printing
collating, 193
with default settings, 193, 194

duplex, 193
Help topics, xxviii
keyboard shortcut for, 184
number of copies, setting, 194
pages per sheet, setting, 184
settings for, 193

printing booklets, 184
printing envelopes, 370
printing mailing labels, 377
printing to PDF/XPS. See PDF files; XPS files
Print Layout view, 29, 31, 183, 445
Print page, 184, 193
Print page of Backstage view, 15
print previewing. See previewing documents
priority, setting in e-mail messages, 383
process diagrams, 204-205, 445
program window

minimizing, 4
overview of, 4
resizing, xv, 4
scrolling contents of, 24

Promote button, 271
promoting outline headings, 271, 445
proofreading, importance of, 63, 68
properties

displaying, 14 
inserting as fields, 319
inserting in fields, 318
viewing, 195-196

Properties dialog box, 197
protecting documents, 384. See also password 

protection
by restricting formatting/editing, 401
by restricting permissions, 400
marking as final, 199

Publish as PDF Or XPS dialog box, 290
Publish button, 304
publishers. See sources
publishing blog posts, 305

as drafts, 304
via e-mail, 301

publishing documents as blog posts, 299
publishing PDF/XPS files. See PDF files; 

XPS files
pull quotes (quote boxes)

defined, 445
inserting, 167
modifying, 296
replacing text in, 167
wrapping text around, 297

pyramid diagrams, 204, 445
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Q
queries, 445
Quick Access Toolbar

adding buttons to, 437-438
customizing, 438
defined, 445
legacy commands, adding, 6
moving, 5
resetting, 438, 440
specifying for active document, 438

Quick Parts. See building blocks; fields
Quick Parts button, 71, 166, 170, 316, 319
Quick Parts gallery, 170
Quick Print button, 439
Quick Styles, 76. See also style sets

applying, 79
applying multiple, 80
changing style set, 76
defined, 445
live preview of, 78
saving, 412-413, 417

Quick Styles button, 176
Quick Styles gallery, 76, 418

displaying, 79
navigating in, 78
removing styles from, 413

Quick Tables, 139-140. See also tables
defined, 445
inserting, 140
overview of, 127

Quick Tables gallery, 140
quote boxes

defined, 445
inserting, 167
modifying, 296
replacing text in, 167
wrapping text around, 297

R
read-only

defined, 445
opening documents as, 24
recommending when users open  

document, 397
recent documents, displaying, 14
Recent page of Backstage view, 14

opening documents from, 23

recoloring pictures, 147
recommending read-only, 397
records, 445
Redo button, 5, 44
redoing editing, 43
red wavy lines under words, 20
reference marks, 330, 445
reference materials, specifying, 57
References tab, 12
Register A Blog Account dialog box, 299
Reject button, 390, 392
rejecting revisions, 390, 392
relationship diagrams, 204, 445
relative positioning, 273
Rename dialog box, 435
renaming ribbon tabs, 435
repairing documents, 24
Repeat button, 44, 89
repeating editing, 44, 89, 122
Repeat Insertion button, 122
replacing styles, 421
replacing text, 51, 54

keyboard shortcut for, 52, 106
options for, 52

Research button, 56
Research Options dialog box, 57
Research task pane

keyboard shortcuts for, 55
opening, 57, 62

Reset Graphic button, 211
resetting diagrams, 211
resizing diagrams, 207, 209, 218
resizing pictures, 146
resizing program window, xv, 4
resizing ribbon, xv
resizing table elements, 129
resizing tables, 128, 133
resolution, screen, xv
responding to comments, 385, 387
Restore Down/Maximize button, 4
Restrict Editing button, 401
Restrict Formatting and Editing task pane, 401
restricting document permissions, 400
restricting formatting and editing, 401-402
return address, setting, 370
reviewers. See also tracking changes; revisions

accepting/rejecting changes from, 390
hiding comments from, 385

reviewing documents. See revisions; 
tracking changes

486 queries



Reviewing pane
closing, 385, 387
displaying, 385
opening, 387
overview of, 385
resizing, 385

Reviewing Pane button, 385, 387
Review tab, 13
revisions. See also tracking changes

accepting, 390, 392
accepting all in document, 395
appearance of, 388, 390
clearing, before distributing document, 195
colors for, 389
customizing display of, 389
defined, 445
displaying, 389
hiding, 389, 392
inline display of, 390
navigating, 386, 389, 392
rejecting, 390, 392
reviewer’s name, displaying, 389, 391

ribbon
button appearance, xiv
buttons, separator between, 438
character formatting with, 88
commands, adding to, 434
commands no longer on, 433
commands on, xiii
customizing, 431-433, 438
decreasing width of, xiv
defined, 446
dynamic nature of, xiv
expanding, 7, 438
groups, 6
groups, displaying all commands in, xiv
groups, removing, 432, 434
hidden groups, displaying, xiv
hiding commands, 7
legacy commands, 433
location of, 5
minimizing, 7
moving commands on, 434
navigating and using, 5
overview of, xiii
resetting customizations, 436
tabs, removing, 432, 433
width, changing, xv

Rich Text Format, 289
right-aligning text, 97, 98
right indent, 96, 102
rights management software, 400
Right Tab button, 125

row headings, 446
rows

deleting, 129
inserting, 129
resizing, 129
setting properties of, 135

.rtf format, 289
rulers and gridlines

displaying, 30, 96
hiding, 33
markers on, 96
setting tab stops with, 97

running Word 2010. See starting Word 2010

S
sample templates, 17
saturation, 446
Save Address List dialog box, 372
Save As dialog box, 18, 20, 288, 290-291, 416
Save As Quick Style dialog box, 412
Save button, 5, 18-20, 369
saving blog posts, 304
saving documents, 18, 20

automatically, 19
creating folders for, 20
in different file format, 288
in .doc format, 289
as earlier version, 22
folders, creating for, 19
in new location, 19, 21
overwriting when, 19
as PDF files, 290
in Rich Text Format, 289
as templates, 415
as Web pages, 297. See also Web pages
as XPS files, 290, 291
in Word 97-2003 format, 289

saving templates, 408
saving themes, 83, 85
scaling printed pages, 184
screen magnification, changing, xvi
screen resolution, xv
ScreenTips

customizing display of, 6
defined, 446
displaying, xxv, 10
feature descriptions, hiding in, 423
language, specifying, 426
overview of, xxv
for search results, 50
viewing, 6
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scroll bar navigation, 24
searching for templates, 18
searching for text, 49, 52

advanced options for, 50, 53
in bilingual dictionary, 59
keyboard shortcut for, 49
matching case when, 51
and replacing, 51, 54
ScreenTips with page numbers for, 50
search direction, specifying, 51
sound-alikes, 51
wildcards in searches, 51, 447

searching Help, xxviii
section breaks

for columns, 116, 118
defining, 446
deleting, 190
formatting mark designating, 190, 192
inserting, 190, 192
overview of, 190

sections, changing margins for, 184
Select Browse Object button, 25, 27
Select button, 118, 129, 296
Select Data Source dialog box, 358
selecting, 446
selecting all

keyboard shortcut for, 41
with Select button, 190

selecting documents, 296
selecting index entry fields, 342
selecting tables, 129
selecting text, 41, 44, 47, 117. See also 

highlighting text
all, 41, 118, 190
by line, 79
deselecting, 42
with similar formatting, 331
in tables, 131

Selection And Visibility task pane, 281
selection area, 41, 446
Selection Pane button, 280
Select Recipients button, 371
Select Table dialog box, 359
Send Backward button, 280
Send button, 384
sending documents via e-mail, 381-382
sending e-mail messages, 384
sentences, selecting, 41
Set Hyperlink ScreenTip dialog box, 314
Set Numbering Value dialog box, 110
Set Target Frame dialog box, 311

Shading button (tables), 139
shading 

cells, 138
paragraphs, 104

Shape Fill button, 214
Shapes gallery, 214
Share page of Backstage view, 15
SharePoint file location, setting default, 424
sharing documents, 15
shortcuts, keyboard, 449

creating, 449, 450
defined, 444
deleting, 451
for bolding text, 89
for building blocks, 70
for centering text, 97, 119
for clearing formatting, 94
for copying text, 43
for cursor placement, 25, 27
for cutting text, 43, 169
for demoting outline headings, 270
for document navigation, 47, 54
for expanding outline headings, 270
for finding text, 49
for Font dialog box display, 92
for font size, 92
for formatting marks, 44
for Go To function, 322
for inserting page breaks, 191
for inserting SmartArt graphics, 205
for justifying text, 97, 118
for left-aligning text, 97
for line breaks, 97
for moving outline headings, 271
for navigation, 31
for pasting text, 43
for printing, 184
for repeating editing, 43, 122
for replacing text, 52, 106
for Research task pane, 55
for right-aligning text, 97
for selecting all, 41, 118
for selecting documents, 296
for underlining text, 89
for undoing editing, 43
moving cursor with, 24

Show/Hide ¶ button, 30, 44, 125, 345
Show Level button, 269
Show Markup button, 385, 386, 390, 395
Show Table of Contents button, xxvii
Shrink Font button, 92
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sidebars
inserting, 168
resizing, 169

side-by-side page display, 32
signatures, digital, 384
sizing diagrams, 207, 209, 218
sizing handles, 446
sizing pictures, 146
SkyDrive, 380
SmartArt button, 204, 205, 217
SmartArt graphics, 203, 446. See also diagrams

gallery of, 212
inserting, 205, 217
keyboard shortcuts for, 205

SmartArt Styles gallery, 212
smart cut and paste, 45
soft page breaks, 188, 446
Sort button, 107, 111
Sort button (tables), 130
sorting lists, 107, 111
sorting mail merge data sources, 357, 361
sorting tables, 130
Sort Text dialog box, 113
source files, 446
Source Manager

entering sources, 347, 348
opening, 348

Source Manager dialog box, 348
sources. See also citations

compiling, 347
editing, 349
entering in Source Manager, 347, 348
inserting, 350
style guide, setting, 348

spaces, automatic insertion of, 45
spacing, column, 120. See also paragraph 

spacing
special text. See text effects
Spelling And Grammar dialog box, 64, 67
spelling errors, fixing, 39

with AutoCorrect, 64-65
flagging of, 20
with shortcut menu, 64, 66
with Spelling and Grammar dialog box, 64

Spelling & Grammar button, 64, 67
Split Cells button, 130
splitting cells, 130
splitting documents, 30
stacked objects, 273

arranging, 280
defined, 446

Start button, 4
Start Enforcing Protection dialog box, 403
starting Word 2010, 4, 9
Start Mail Merge button, 358, 375
Start menu, displaying, 4
statistics, 69
status bar

cursor location on, 24
default items on, 8
defined, 446

strong passwords, 397
style area pane, 268
Style Pane Options dialog box, 409
styles

applying, 409-411, 415
creating, 413, 417
deleting, 413
displaying available, 409
displaying style area pane, 268
editing, 413
limiting, 400-401
modifying, 411-413, 417
overview of, 409
previewing, 410
removing from gallery, 413
replacing, 421
reverting to original, 413
updating, 411, 417

styles, character, 411
style sets. See also Quick Styles

changing, 76, 80
displaying list of, 77
live preview of, 77
saving, 412

styles, linked, 411
styles, paragraph, 411
styles, picture, 148
styles, table, 136-137
styles, table of contents, 333, 335-336
Styles task pane, 409
subdocuments, 269
subentries, 446
summaries, viewing, 197
switches, 446
switches, in fields, 316
switching documents, 35
switching templates, 420
Switch Windows button, 284, 312
synonyms. See also Thesaurus

defined, 55
searching for, 55, 61
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T
tabbed lists. See also tab stops

defined, 446
entering text for, 123
formatting text in, 124
overview of, 123
setting up, 123

tab leaders, 446
Table button, 130, 140, 283
table columns

deleting, 129
inserting, 129
resizing, 129
setting width of, 135

Table of Contents button, 333
Table Of Contents dialog box, 333, 335
Table Of Contents gallery, 333
Table Properties dialog box, 135
tables, 115. See also nested tables; Quick Tables

aligning text, 132, 139
alt text, entering, 135
banded rows, 137
borders around cells, 138
borders, removing, 284
calculations in, 134
captions, inserting, 338
cell width, setting, 135
centering text in, 131
column width, setting, 133, 135
components of, 128
converting to/from regular text, 128, 132
copying, 284
creating, 126, 130
cutting and pasting, 129
deleting rows/columns/cells, 129
drawing, 127, 282-283
entering text, 128, 131
formatting, 136
formatting text in, 131
headings, turning sideways, 139
inserting rows/columns/cells, 129, 131-132
margin settings, 135
merging cells, 129, 131
move handle, 128-129, 133
moving, 129
navigating in, 128
overview of, 125
page layout with, 282
previewing, 130
resizing, 129, 133
row properties, setting, 135

saving as Quick Tables, 141
selecting elements in, 129, 131
shading cells, 138
size handle, 128, 133
sorting, 130
splitting cells, 130
styles, applying, 285
total rows, 137
width, setting, 135

tables of authorities
creating, 339
defined, 446

tables of contents. See also indexes
creating, 332-333, 335
defined, 446
deleting, 335
formatting, 333
in Help window, displaying, xxvii
linking entries in, 332
overview of, 329
paragraph spacing, setting, 337
selecting field, 336
styles for, 333, 335-336
tab leaders, setting, 336
updating, 333, 336

tables of figures
creating, 338
defined, 446

table styles, 136
defined, 446
previewing, 137

Table Styles gallery, 136-137
tabs, 5, 446
tabs, keyboard, 33. See also formatting marks
tabs, ribbon

customizing, 432
removing, 432, 433
renaming, 435

tab stops. See also tabbed lists
center-aligned, setting, 124
default, 97
defined, 446
deleting, 98
left-aligned, setting, 97, 98
moving, 98
precisely placing, 98
right-aligned, setting, 125

tagging documents, 197
tags, HTML, 293
templates

applying, 414
attaching, 408, 420
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building blocks in, 408
Building Blocks template, 408
Compatibility Mode, 406
components of, 407-408
creating, 408
creating documents with, 406
default, 406
defined, 447
displaying, 15
downloading, 406
file name extensions, 408
global, 408, 421
graphic elements, 407
macros in, 408
Normal template, 406, 408-409
opening, 419
organizing, 416
placeholders in, 407
previewing, 18
recently used, 17
sample, installed with Word, 17, 406
saving, 408
saving documents as, 415
searching for, 18
switching, 420

Templates And Add-Ins dialog box, 420, 431
Templates folder, 408
text

entering, 19, 40
formatting in columns, 116
hiding, 30, 342
selecting. See selecting text

text boxes
defined, 447
drawing, 172
inserting, 167
linking, 172
overview of, 159
positioning, 172
replacing text in, 167
saving to Quick Parts Gallery, 170

Text Direction button, 139
text effects

applying, 77, 81, 92
defined, 443
live preview of, 81

Text Effects button, 77, 81
text files, 289
Text Highlight Color button, 93, 439
Text pane

closing, 207
opening, 206

Text Pane button, 206
textures, applying to backgrounds, 154
text wrapping, 274

absolute vs. relative positioning, 273
breaks. See line breaks
defined, 447
around diagrams, 208
layout options for, 274
around objects, 273, 274
around quote boxes, 297
around WordArt, 175

theme colors, 83
changing, 93
previewing effects of, 12

Theme Colors button, 83
Theme Fonts button, 84
themes

applying, 82-83
color set, changing, 84
defined, 447
displaying gallery of, 12
font set, changing, 85
live preview of, 83
from Microsoft Office Online Web site, 83
mixing and matching, 83
overview of, 82
saving, 83, 85

Themes button, 12, 82-83
Thesaurus

finding synonyms in, 61
overview of, 55

Thesaurus button, 55, 61
3-D borders, 104
thumbnails

defined, 447
of formatting options, 9

tick-marks, 447
title bar, 4
title, document, 196
titles, Web page, 297
toolbars. See specific toolbars
total rows in tables, 137
Track Changes button, 388, 390
Track Changes Options dialog box, 389
tracking changes. See also revisions

in balloons, 389-390, 392
final version, displaying, 392
options, setting, 389
toggle button, adding, 388
turning off, 393
turning on, 388, 390
user information, changing, 389
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Translate button, 58, 62
translating text

entire documents, 60
options for, 62

Translation Language Options dialog box, 60
Trust Center, 428-429
Trust Center dialog box, 429
trusted locations, setting, 429
.txt format, 289
typos. See spelling errors, fixing

U
Underline button, 89
underlining text, 89
Undo button, 5, 44, 46, 270, 276
undoing editing, 43-44, 46
unencrypted password protection, 396
unloading add-ins, 431
Update Citations And Bibliography button, 348
Update Index button, 342, 346
Update Table button, 336
Update Table Of Contents dialog box, 336
updating bibliographies, 348
updating cross-references, 326
updating fields, 317, 318, 320

automatically, 319
updating indexes, 342, 346
updating tables of contents, 333, 336
updating styles, 411, 417
upgrading Word, x, xi
uploading pictures to blogs, 303
uppercase, formatting text as, 94
user information, 389
user interface color scheme, 423
user interface elements, 3-4
user name

AutoText for, changing, 166
setting, 423

V
version control, 380
vertical scoll bar, 24
View Ruler button, 96
views, switching, 29. See also specific views
View Shortcuts toolbar, 8, 29, 447
View tab, 13

Document Views group, 29
Macros group, 30

W
Web browsers

opening Web pages in, 298
previewing documents in, 29, 34
setting for Web pages, 294-295

Web Layout button, 34, 295
Web Layout view, 29, 295, 447
Web links (hyperlinks), 309

appearance of, 310, 312
in blog posts, 304
deleting, 310
editing, 310, 314
for e-mail addresses, 313
following, 312
inserting, 310
jumping to target, 310, 312
opening in new window, 312
ScreenTips for, 312, 314
targets, setting, 310, 311

Web logs. See blogs
Web Options dialog box, 294, 295
Web Page, Filtered format, 294
Web pages, 447. See also HTML format

browsers, setting, 294-295
Compatibility Checker, 298
conversion settings, 427
entering text, 298
Filtered format, 294
indentation, changing, 296
Office-specific tags, removing, 294
opening, 298
previewing documents as, 295
quote boxes, modifying, 296
saving documents as, 293, 297
Single File format, 294
titles, setting, 297
unsupported formatting error, 293

Web Page, Single File format, 294
white space between pages, hiding, 31
wide margins, 186, 192
widows

defined, 188, 447
setting options for, 188, 191

wildcards in searches, 51, 447
windows, switching, 284
Windows Live Online Services, 380
Windows Live SkyDrive, 380
Windows Live Spaces, 300, 302
Windows Live Translator, 60
Word 2003, upgrading from, xi
Word 2007, upgrading from, x
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Word 2010
closing, 4
compatibility with earlier versions, 22, 289
first time starting, 9
new features in, x
starting, 4, 9
upgrading to, x, xi
uses for, ix

WordArt button, 174
WordArt objects

centering, 174
converting text into, 173
defined, 447
inserting, 173, 174
overview of, 173
positioning, 174
starting new lines in, 174
styles, applying, 176
text wrapping, 175

word count, 69
Word Count button, 69
Word Count dialog box, 69
Word Help button, xxv, xxvi, 7, 447
Word Help window

navigating, xxvii
opening, xxvi
printing from, xxviii
searching, xxviii
table of contents, displaying, xxvii
topics, displaying, xxvi

Word icon, 4
Word Options dialog box, 6, 15, 295, 370, 422, 

423, 426, 431, 449
word processing, 3, 447
words, selecting, 41, 44
word wrap, 447
works cited, 347. See also citations; sources
wrapping text, 175, 274, 447

absolute vs. relative positioning, 273
around diagrams, 208
around objects, 273, 274
around quote boxes, 297
layout options for, 274

Wrap Text button, 175, 208, 274, 297
Wrap Text gallery, 274

X
x-axis, 447
XML data, removing custom, 198
XML (Extensible Markup Language), 442
XML file formats, 22
XML Paper Specification (XPS). See XPS files
XML tags, 446
XPS files

creating, 290
opening after publishing, 292
optimizing size, 290
options for, 290, 292
page range, setting, 292
printing documents to, 199
saving documents as, 290, 291
sending documents as, 382

XPS Viewer, 292

Y
y-axis, 447

Z
z-axis, 447
Zoom button (preview), 185
Zoom dialog box, 31, 185
Zoom In button, 33
zooming in/out, 30, 78

by percentage, 33
displaying multiple pages, 32, 185
to full page, 152

Zoom Level button, 8, 30, 31, 33, 152, 161
Zoom Out button, 33, 78, 167
Zoom Slider, 8
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